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Introducing NetBackup for
SharePoint Server Server

This chapter includes the following topics:

■ About NetBackup for SharePoint Server

■ Features of NetBackup for SharePoint Server

■ SharePoint Server backup operations

■ SharePoint Server restore operations

■ Limitations on SharePoint Server backups and restores

■ NetBackup File System Daemon

About NetBackup for SharePoint Server
NetBackup for SharePoint Server extends the capabilities of NetBackup to include
online backups and restores SharePoint Server. The NetBackup agent for Microsoft
SharePoint Server is an optional, add-on component to the NetBackup for Windows
client software. Because this product is tightly integrated with the Backup, Archive,
and Restore interface, this manual provides only an overview of NetBackup
functionality. Backup operations and restore operations for SharePoint Server are
identical to other NetBackup file operations, except where noted.

Microsoft SharePoint Server or Microsoft Office SharePoint Server may be
abbreviated to either SharePoint Server or to SharePoint. Unless otherwise noted,
the text implies SharePoint Foundation when SharePoint is discussed.
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Features of NetBackup for SharePoint Server
Table 1-1 describes the features for the NetBackup for SharePoint Server Agent.

Table 1-1 NetBackup for SharePoint Server Agent features

DescriptionFeature

SharePoint Server objects can be backed up without taking the SharePoint Server offline.
SharePoint services and data are available during the backup.

Online backup

NetBackup supports full and differential-incremental backups of SharePoint.SharePoint Server
backup methods

Tight integration with NetBackup means the following:

■ An administrator already familiar with NetBackup procedures and software can easily
configure and use NetBackup to perform SharePoint Server backup and restore
operations.

■ Features and strengths of the NetBackup product suite are available to the SharePoint
Server backup user. These features include scheduled and user-directed operations,
backups of multiple data streams, and in-line tape copy. These features are described
in detail.
See the NetBackup Administrator’s Guide, Volume I.

Tight NetBackup
integration

You can administer the backup and recovery of multiple SharePoint Server installations
from a central location.

Central administration

SharePoint Server backups are saved directly to a wide variety of storage devices that
NetBackup supports.

Media management

Administrators can set up schedules for automatic, unattended backups for local or remote
clients across the network. These backups are managed entirely by the NetBackup server
from a central location. The administrator can also manually back up the clients. Auto
discovery is used for SharePoint Server installations. The topology is read from the
SharePoint front-end Web server and the backup selection list is automatically built.

Automated backups

A user can perform backups of SharePoint Server resources through the Backup, Archive,
and Restore client interface on the front-end Web server.

User-directed backups

NetBackup can back up and restore standalone installations of SharePoint Foundation or
Windows SharePoint Services.

Backups and restores of
standalone SharePoint
Foundation or Windows
SharePoint Services
(WSS)

VMware backups that protect SharePoint Server provide granular recovery, complete
protection of the farm, and protection of the SharePoint components in the Windows files
system.

Support for VMware
backups that protect
SharePoint
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Table 1-1 NetBackup for SharePoint Server Agent features (continued)

DescriptionFeature

Compression increases backup performance over the network and reduces the size of the
backup image that is stored on the disk or tape. NetBackup does not support compression
of the backups that use Granular Recovery Technology (GRT).

Compression of backups

When the Encryption attribute is enabled, the server encrypts the backup for the clients
that are listed in the policy. NetBackup does not support encryption of any backups that
use GRT.

Encryption

An administrator who uses the Backup, Archive, and Restore interface can browse
SharePoint Server backups and select the ones to restore.

Restore operations

NetBackup Accelerator can reduce by up to 90% the time it takes to perform a VMware
backup that protects SharePoint. By reducing the backup time, it is easier to perform the
VMware backup within the backup window. Accelerator support for SharePoint currently
restricts backups to the full schedule type. This restriction also exists for a VMware backup
that protects SharePoint without Accelerator.

Support for NetBackup
Accelerator with VMware
backups

When a backup uses GRT, users can restore individual lists, items, and documents sets
directly from any full database backup of a Web application. This feature adds an extra
step that identifies the items within the database. This step lets you recover individual items
later. (Note that you must create a separate backup for the full farm.)

Restores of individual
items and document sets
using Granular Recovery
Technology (GRT)

Claims-based authentication (CBA) is supported for web applications in SharePoint. The
following providers are supported:

■ Windows authentication (LDAP)
■ Facebook
■ LinkedIn
■ Live Id
■ Forms-based authentication (FBA), using SQL Server
■ ADFS 2.0

Support for claims-based
authentication

You can redirect the restore of the following:

■ SharePoint web application within a farm.
■ SharePoint web application to another farm.
■ SharePoint Content database to another SQL Server instance, to take advantage of

data recovery from an unattached content database.

Redirected restore

Backup and recovery of SharePoint Server databases are fully supported in a multi-tenant
environment. NetBackup does not support GRT with Microsoft SharePoint Server backups
in a multi-tenant SharePoint environment.

Multi-tenant
environments

11Introducing NetBackup for SharePoint Server Server
Features of NetBackup for SharePoint Server



Table 1-1 NetBackup for SharePoint Server Agent features (continued)

DescriptionFeature

You can restore the backups that were created with previous versions of NetBackup.
However, features in the current release are not supported with any backups that were
created with previous versions.

Support for any backups
that were created with
previous NetBackup
versions

SharePoint Server backup operations
You can use the NetBackup for SharePoint Server agent to back up the entire
SharePoint Server farm or individual components. NetBackup provides the following
methods to perform backups:

■ Automatic

■ Manual

■ User-directed

For general information on backup methods in NetBackup, see the NetBackup
Administrator’s Guide, Volume I.

The NetBackup administrator can schedule the backups that occur automatically
and unattended under the control of the NetBackup server. The following types of
automatic backups are available:

The entire contents in the backup selections list are backed
up.

Full schedule

Only the contents that have been added or changed since the
previous full or incremental are included in the backup.

Differential incremental

Manual backup may be used for special events. A manual backup includes all the
items in the backup selections list of the policy you selected for backup.

User directed backups require a User Backup schedule to be defined on a
SharePoint policy on the NetBackup server. A user-directed backup includes the
entire contents of the items that are selected for backup. This type of backup is
only supported from the SharePoint application host, not on other hosts where only
SharePoint objects are present.

12Introducing NetBackup for SharePoint Server Server
SharePoint Server backup operations

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


SharePoint Server restore operations
Use the Backup, Archive, and Restore interface to initiate SharePoint Server restore
operations. This interface lets you select the NetBackup server from which the
objects are restored and the client whose backups you want to browse. Based upon
these selections, you can browse the backup history, select individual items and
launch a restore. The NetBackup Recovery Assistant lets you restore SharePoint
resources with one click and determines the sequence in which the resources are
restored.

An administrator can browse for and restore databases and individual items. Users
also can restore the security settings on a selected item. Objects that users can
restore include the following:

■ One or more databases

■ Individual documents in a Document library

■ Entire sites

■ Subsites

■ Entire lists or libraries

■ Document sets

■ Individual list items or documents

Limitations on SharePoint Server backups and
restores

The following limitations exist when you perform backups and restores of SharePoint
Server:

■ Due to Microsoft API limitations, NetBackup does not support backups of the
Application Registry service application.

■ Project Server databases are not protected.

■ Reporting Services are not supported.

■ The FAST Search service application under SharePoint is not protected.

■ The following cannot be redirected to another web application:

■ Documents and folders

■ Farm Configuration database and Single Sign-on database

■ Index Files or Index database

13Introducing NetBackup for SharePoint Server Server
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■ NetBackup does not support restores of customized SharePoint Solution
Packages (.wsp) or third-party Web Part customizations.

■ Web Parts on the home page of the site collection and subsite do not retain
their formatting when you restore with GRT at the site collection and subsite
level.

■ NetBackup does not support GRT restores of deleted lists and PerformancePoint
Dashboards. For example, Microsoft OneDrive sync fails after you perform the
GRT restore of the list or the OneDrive web app that is deleted.

■ Restoring a SharePoint Help Search database and index files results in a
successful restore. However, the SharePoint Help Search is not extended to
use the restored database and index files.

■ When you direct items to a file system, any list items you selected are not
restored and appear as 0-KB files.

■ (SharePoint 2016 and later) restore jobs related to the Basic Search Center
template fail with an error message.

■ For limitations on operations with Granular Recovery Technology (GRT), see
the following topic:
See “Limitations and conditions for restores that use SharePoint Granular
Recovery Technology (GRT)” on page 38.

■ The SharePoint agent is supported in FIPS-compliant mode. SharePoint internally
uses encryption algorithms that do not comply with FIPS standards. TheWindows
FIPS policy blocks the MD5 hashing algorithms that SharePoint uses. Therefore,
the OS-level FIPS policy should be disabled for the SharePoint restores for
successful operation. Note that NetBackup-FIPS is supported for protecting
SharePoint. See the following articles for more details:
FIPS and SharePoint Server
SharePoint 2016 and FIPS

■ Redirected restore functionality is not supported with SQL availability group
(Always On) configuration.

NetBackup File System Daemon
The NetBackup File System Daemon (NBFSD) on the NetBackup media server is a
process that allows NetBackup clients to mount, browse, and read NetBackup (tar)
images. This process is used with a client for Granular Recovery Technology (GRT)
operations. These operations include backups, browsing for backup images,
restores, and duplication.
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Installing NetBackup for
SharePoint Server Server

This chapter includes the following topics:

■ Planning the installation of NetBackup for SharePoint Server

■ Verifying the operating system and platform compatibility

■ NetBackup server and client requirements

■ SharePoint software requirements

■ Requirements for installing the SQL Server back-end servers in a cluster

■ License for NetBackup for SharePoint Server

Planning the installation of NetBackup for
SharePoint Server

Perform the following tasks before you use NetBackup for SharePoint Server.

Table 2-1 Installation steps for NetBackup for SharePoint Server

DescriptionActionStep

See “Verifying the operating system and platform compatibility
” on page 16.

Verify the operating system and
platform compatibility.

Step 1

See “NetBackup server and client requirements” on page 16.Verify the NetBackup software
requirements for NetBackup for
SharePoint Server.

Step 2
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Table 2-1 Installation steps for NetBackup for SharePoint Server (continued)

DescriptionActionStep

See “License for NetBackup for SharePoint Server” on page 18.Verify that primary server has a valid
license for NetBackup for SharePoint
Server and any NetBackup options.

Step 3

Verifying the operating system and platform
compatibility

Verify that the NetBackup for SharePoint Server agent is supported on your operating
system or platform.

To verify operating system and compatibility

1 Go to the NetBackup compatibility list site.

https://www.veritas.com/support/en_US/article.100040093

2 Select the link for the following document:

Application/Database Agent Compatibility List

3 For information on support for VMware, see the following document:

Support for NetBackup in a Virtual Environment

NetBackup server and client requirements
Before you install NetBackup, review the requirements for the NetBackup server
and the NetBackup clients.

NetBackup server requirements
Verify that the following requirements are met for the NetBackup server:

■ The NetBackup server software is installed and operational on the NetBackup
server.
See the NetBackup Installation Guide.

■ Make sure that you configure any backup media that the storage unit uses. The
number of media volumes that are required depends on several things:

■ The devices that are used and the storage capacity of the media.

■ The sizes of the databases that you want to back up.

■ The amount of data that you want to archive.
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■ The size of your backups.

■ The frequency of backups or archives.

■ The length of retention of the backup images.
See the NetBackup Web UI Administrator’s Guide.

NetBackup client requirements
Verify that the following requirements are met for the NetBackup clients:

■ Front-end web servers: Install the NetBackup client on each web server in the
environment.

■ Index server: Install the NetBackup client on the system that hosts the SharePoint
index.

■ Search servers: No NetBackup software is required on these hosts.

■ SQL Servers: Install the NetBackup client on any SQL Server that hosts a
SharePoint database. For cluster environments, install the client on each node
of a clustered SQL Server that hosts the configuration database.

■ In a VMware environment, install the NetBackup client software on the virtual
machines that are part of the SharePoint farm.

■ To use the new features that are included in NetBackup for SharePoint Server
in NetBackup 11.1, you must upgrade your NetBackup for SharePoint Server
clients to NetBackup 11.1. The NetBackup media server must use the same
version as the NetBackup for SharePoint Server client or a higher version than
the client.

SharePoint software requirements
Verify the following regarding the SharePoint server software on the NetBackup
server or client:

■ The SharePoint server software must be installed and operational.
Refer to the Application/Database Agent Compatibility List for supported versions
of the SharePoint server software.

■ For NetBackup 11.1 and later and for SharePoint versions 2016 and later, the
Microsoft .NET Framework 4.8 is installed on the SharePoint servers.

■ When you usemultiple front-end SharePoint servers, all front-end server websites
must be uniformly identified in IIS. Identify the sites with either host headers or
IP addresses, but not both. An environment that mixes host headers and IP
addresses across multiple front-end servers is not supported.
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■ To prevent restore failures, the IIS Default Application Pool identity must be a
valid SharePoint user ID.

■ The SharePoint user should be an administrator user account.

See “NetBackup server and client requirements” on page 16.

Requirements for installing the SQL Server
back-end servers in a cluster

NetBackup supports clustering of a back-end SQL Server in a Windows Server
Failover Clustering (WSFC) environment. The same version of NetBackup must
be used on each node in the cluster.

For more information, see your WSFC documentation.

License for NetBackup for SharePoint Server
The NetBackup for SharePoint Server agent is installed with the NetBackup client
software. No separate installation is required. A valid license for the agent must
exist on the primary server.

More information is available on how to add licenses.

See the NetBackup Web UI Administrator’s Guide.
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Installing and configuring
NFS for SharePoint
Granular Recovery

This chapter includes the following topics:

■ About installing and configuring Network File System (NFS) for SharePoint
Granular Recovery

■ Requirements for SharePoint Granular Recovery

■ Configurations that are supported for SharePoint Granular Recovery

■ About configuring Services for Network File System (NFS)

■ Configuring a UNIXmedia server andWindows clients for backups and restores
that use Granular Recovery Technology (GRT)

■ Configuring a different network port for NBFSD

About installing and configuring Network File
System (NFS) for SharePoint Granular Recovery

NetBackup uses Granular Recovery Technology (GRT) and Network File System
(NFS) to recover the individual objects that reside within a database backup image,
such as:

■ A user account from an Active Directory database backup

■ Email messages or folders from an Exchange database backup

■ A document from a SharePoint database backup
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The NetBackup client mounts and accesses a mapped drive over a secure
connection to the NetBackup media server. The NetBackup media server handles
the client requests through the NetBackup File System (NBFS) service, or NBFSD.

Multiple NetBackup agents that support GRT (for example, Exchange, SharePoint,
and Active Directory) can use the same media server.

Requirements for SharePoint Granular Recovery
Table 3-1 Requirements for SharePoint Granular Recovery

DescriptionActionStep

See the Application/Database Agent Compatibility
List.

You have a supported SharePoint Server
configuration.

Step 1

See the Software Compatibility List (SCL).You have a media server platform that supports
GRT.

Step 2

On all SQL Server back-end servers and themedia
server, ensure that each node has an assigned
drive letter on which to mount the backup image.

Step 3

See “About configuring Services for Network File
System (NFS)” on page 21.

See “Configuring a UNIX media server and
Windows clients for backups and restores that use
Granular Recovery Technology (GRT)”
on page 31.

Enable or configure NFS for your environment:

■ Windows media server and clients
■ UNIX media server and Windows clients

Step 5

Configurations that are supported for SharePoint
Granular Recovery

For information on the SharePoint and SQL Server back-end versions and the
Windows Server releases that are supported for Granular Recovery Technology
(GRT) see the Application/Database Agent Compatibility List.

For information on the media server platforms that are supported for Granular
Recovery Technology (GRT) see the Software Compatibility List (SCL).
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About configuring Services for Network File
System (NFS)

To restore individual items from a database backup, you must configure Services
for Network File System (NFS) on the NetBackup media server and on the SQL
Server back-end servers.

Note: For VMware backups and restores of SharePoint, the only systems that
require configuration of NFS are the following: the systems that you use to browse
for backups or the systems you use to perform restores. This configuration is not
needed to capture the data during backups of the virtual machine.

Table 3-2 Configuring NFS on Windows 2012, 2012 R2, or later

DescriptionActionStep

Note: For VMware backups that protect SharePoint, you do not need to
configure NFS on the media server.

On the media server do the following:

■ Stop and disable the ONC/RPC Portmapper service, if it exists.
■ Enable NFS.

See “Enabling Services for Network File System (NFS) on a media
server” on page 22.

■ Stop the Server for NFS service.
See “Disabling the Server for NFS” on page 29.

■ Stop the Client for NFS service.
See “Disabling the Client for NFS on the media server” on page 27.
Note: If a SQL Server back-end server resides on the media server,
do not disable the Client for NFS.

■ Configure the portmap service to start automatically at server restart.
Issue the following from the command prompt:
sc config portmap start= auto

This command should return the status [SC] ChangeServiceConfig
SUCCESS.

Configure NFS on the media
server.

Step 1

On the SQL Server back-end servers, do the following:

■ Enable NFS on the clients.
See “Enabling Services for Network File System (NFS) on a client”
on page 25.

■ Stop the Server for NFS service.
See “Disabling the Server for NFS” on page 29.

Configure NFS on the SQL
Server back-end servers.

Step 2

21Installing and configuring NFS for SharePoint Granular Recovery
About configuring Services for Network File System (NFS)



Enabling Services for Network File System (NFS) on a media server
To restore individual items from a backup that uses Granular Recovery Technology
(GRT), you must enable Services for Network File System (NFS) on the media
server. When this configuration is completed, you can disable any unnecessary
NFS services.

To enable Services for Network File System (NFS) on a media server

1 Open the Server Manager.

2 From the Manage menu, click Add Roles and Features.

3 In the Add Roles and Features Wizard, on the Before You Begin page, click
Next.
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4 On the Select installation type page, select Role-based or feature-based
installation.

5 Click Next.

6 On the Server Selection page, click Select a server from the server pool
and select the server. Click Next.
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7 On the Server Roles page, expand File and Storage Services and File and
iSCSI Services.

8 Click File Server and Server for NFS. When you are prompted, click Add
Features. Click Next.

9 If the media server is also an SQL Server back-end server, on the Features
page, click Client for NFS. Click Next.
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10 On the Confirmation page, click Install.

11 Disable any unnecessary services, as follows:

■ If you have a single host that functions as both the media server and the
SQL Server back-end server, you can disable the Server for NFS service.
See “Disabling the Server for NFS” on page 29.

■ For a host that is only the NetBackup media server, you can disable the
Server for NFS and the Client for NFS services.
See “Disabling the Server for NFS” on page 29.
See “Disabling the Client for NFS on the media server” on page 27.

Enabling Services for Network File System (NFS) on a client
To restore individual items from a backup that uses Granular Recovery Technology
(GRT), you must enable Services for Network File System (NFS). When this
configuration is completed on the SQL Server back-end servers, you can disable
any unnecessary NFS services.

To enable Services for Network File System (NFS) on a Windows client

1 Open the Server Manager.

2 From the Manage menu, click Add Roles and Features.
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3 In the Add Roles and Features Wizard, on the Before You Begin page, click
Next.

4 On the Select installation type page, select Role-based or feature-based
installation.

5 Click Next.

6 On the Server Selection page, click Select a server from the server pool
and select the server. Click Next.
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7 On the Server Roles page, click Next.

8 On the Features page, click Client for NFS. Click Next.

9 On the Confirmation page, click Install.

Disabling the Client for NFS on the media server
After you enable Services for Network File System (NFS) on a host that is only a
NetBackup media server, you can disable the Client for NFS.

To disable the Client for NFS on the NetBackup media server

1 Open the Server Manager.

2 In the left pane, expand Configuration.
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3 Click Services.

4 In the right pane, right-click on Client for NFS and click Stop.

5 In the right pane, right-click on Client for NFS and click Properties.
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6 In the Client for NFS Properties dialog box, from the Startup type list, click
Disabled.

7 Click OK.

Disabling the Server for NFS
After you enable Services for Network File System (NFS) on the media server and
on the SQL Server back-end servers, you can disable Server for NFS.

To disable the Server for NFS

1 Open the Server Manager.

2 In the left pane, expand Configuration.
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3 Click Services.

4 In the right pane, right-click on Server for NFS and click Stop.

5 In the right pane, right-click on Server for NFS and click Properties.
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6 In the Server for NFS Properties dialog box, from the Startup type list, click
Disabled.

7 Click OK.

8 Repeat this procedure for the media server and for each SQL Server back-end
server.

Configuring a UNIX media server and Windows
clients for backups and restores that useGranular
Recovery Technology (GRT)

To perform backups and restores that use Granular Recovery Technology (GRT),
perform the following configuration if you use a UNIX media server and Windows
clients:

■ Confirm that your media server is installed on a platform that supports granular
recovery.
For more information about supported platforms, see the NetBackup Enterprise
Server and Server - OS Software Compatibility List at the following URL:
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■ No other configuration is required for the UNIX media server.

■ Enable or install NFS on the SQL Server back-end servers.
See “Enabling Services for Network File System (NFS) on a media server”
on page 22.
See “Enabling Services for Network File System (NFS) on a client” on page 25.

■ You can configure a different network port for NBFSD.
See “Configuring a different network port for NBFSD” on page 32.

Configuring a different network port for NBFSD
NBFSD runs on port 7394. If another service uses the standard NBFSD port in your
organization, you 20can configure the service on another port. The following
procedures describe how to configure a NetBackup server to use a network port
other than the default.

To configure a different network port for NBFSD (Windows server)

1 Log on as administrator on the computer where NetBackup server is installed.

2 Open Regedit.

3 Open the following key.:

HKEY_LOCAL_MACHINE\SOFTWARE\Veritas\NetBackup\CurrentVersion\Config

4 Create a new DWORD value named FSE_PORT.

5 Right-click on the new value and click Modify.

6 In the Value data box, provide a port number between 1 and 65535.

7 Click OK.

To configure a different network port for NBFSD (UNIX server)

1 Log on as root on the computer where NetBackup server is installed.

2 Open the bp.conf file.

3 Add the following entry, where XXXX is an integer and is a port number between
1 and 65535.

FSE_PORT = XXXX
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Configuring NetBackup for
SharePoint Server

This chapter includes the following topics:

■ About configuring NetBackup for SharePoint Server

■ About a SharePoint non-granular backup vs. a backup that uses Granular
Recovery Technology (GRT)

■ Configuring a SharePoint backup that uses Granular Recovery Technology
(GRT)

■ Configuring the logon account for the NetBackup Client Service for NetBackup
for SharePoint Server

■ Configuring the logon account for the NetBackup Legacy Network Service and
the NetBackup Legacy Client Service

■ Configuring SharePoint client host properties

■ Configuring mappings for restores of a distributed applications, clusters, or virtual
machines

■ Reviewing the auto-discovered mappings

■ Perform a manual backup

4Chapter



About configuring NetBackup for SharePoint
Server

To successfully perform backups and restores of SharePoint Server, complete the
following steps. For additional information on how to configure NetBackup in
preparation of VMware backups that protect SharePoint, refer to the following topics.

See “About protecting an application database with VMware backups” on page 95.

Table 4-1 Configuring NetBackup for SharePoint Server

DescriptionActionStep

GRT lets you restore individual documents, etc.,
from a database backup. GRT is an option
limited to certain versions of SharePoint Server
and Windows Server. GRT is included in
VMware backups that protect SharePoint.

See “Configuring a SharePoint backup that uses
Granular Recovery Technology (GRT)”
on page 36.

Review the information for configuring the
backup and the restore operations that use
Granular Recovery Technology (GRT).

Step 1

Required if you want to restore individual items
with GRT.

See “Configuring the logon account for the
NetBackup Client Service for NetBackup for
SharePoint Server ” on page 39.

Configure the NetBackup Client Service.Step 2

See “Configuring the logon account for the
NetBackup Legacy Network Service and the
NetBackup Legacy Client Service” on page 40.

Configure the NetBackup Legacy Network
Service and (optionally) the NetBackup Legacy
Client Service.

Step 3

See “Configuring SharePoint client host
properties” on page 40.

Configure the host properties for SharePoint
clients.

Step 4

Map the application hosts and component hosts
in your environment. Configure thesemappings
in theDistributed application restoremapping
host property on the primary server.

See “Configuring mappings for restores of a
distributed applications, clusters, or virtual
machines ” on page 45.

Configure the mappings for distributed
application restores.

Step 5
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Table 4-1 Configuring NetBackup for SharePoint Server (continued)

DescriptionActionStep

Approve each valid auto-discovered mapping
that NetBackup discovers in your environment.

See “Reviewing the auto-discovered mappings”
on page 46.

On the NetBackup server, review the
auto-discovered mappings for the hosts in your
environment.

Step 6

See “About backup policies for granular backup
and recovery of SharePoint Server ” on page 52.

See “About backup policies for SharePoint farm
backup and recovery” on page 53.

See “About backup policies for disaster recovery
of SharePoint Server” on page 55.

See “About VMware backup policies that protect
SharePoint Server” on page 57.

Select the backup and the recovery strategies
that fit your environment.

Step 7

See “Perform a manual backup” on page 50.Test your configuration settings.Step 8

About a SharePoint non-granular backup vs. a
backup that uses Granular Recovery Technology
(GRT)

Non-granular backups allow the restore of SharePoint objects at the level of a Web
Application. This type of backup also allows the restore at the level of the Single
Sign-on database. Individual items cannot be restored from non-granular backups.

To restore individual items using Granular Recovery Technology (GRT), NetBackup
performs a granular-level backup of the SharePoint Web Application. You can
restore the entire database or you can restore items individually. Items can then
be restored to the existing Web Application.

Note: The farm databases (Configuration, Single Sign-on, Index Files and their
Search databases) cannot be backed up with a policy that is enabled for individual
item restores (GRT). For comprehensive farm disaster recovery, back up those
databases with a separate policy where granular recovery is disabled.

Table 4-2 describes what SharePoint objects can be restored with non-granular
and granular-level backups.

35Configuring NetBackup for SharePoint Server
About a SharePoint non-granular backup vs. a backup that uses Granular Recovery Technology (GRT)



Table 4-2 SharePoint Server non-granular backup vs. a backup that uses
Granular Recovery Technology

Can be restored from
a backup that uses
Granular Recovery
Technology

Can be restored from
a non-granular
backup

Object

NoYes*Configuration database

NoYes*Single Sign-on database

NoYes*Global Settings

NoYes*Index Files and their Search
databases

YesYesWeb Applications or Content
databases

YesNoSite collections

YesNoSubsites

YesNoIndividual lists or libraries

YesNoIndividual documents or list items

* Only restore these items as part of a farm restore.

Configuring a SharePoint backup that uses
Granular Recovery Technology (GRT)

Before you configure for granular recovery with NetBackup, ensure that you have
met the requirements for using Granular Recovery Technology (GRT). These
requirements include the configuration of NFS.

See “Requirements for SharePoint Granular Recovery” on page 20.
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Table 4-3 Configuring a SharePoint backup that uses Granular Recovery
Technology (GRT)

DescriptionActionStep

See “Disk storage units supported with SharePoint
Granular Recovery Technology (GRT)” on page 37.

See “Limitations and conditions for restores that use
SharePoint Granular Recovery Technology (GRT)”
on page 38.

Review the limitations and conditions.Step 1

See “Configuring the logon account for the NetBackup
Client Service for NetBackup for SharePoint Server
” on page 39.

See “Configuring the logon account for the NetBackup
Legacy Network Service and the NetBackup Legacy
Client Service” on page 40.

On all SQL Server back-end servers, configure the
NetBackup services log on accounts:

■ NetBackup Client Service as the SharePoint
administrator

■ NetBackup Legacy Network Service as the Local
System account

■ (Optional) NetBackup Legacy Client Service as
the Local System account

Step 2

See “Configuring local security privileges for the
SharePoint Servers” on page 43.

On each SharePoint server in the farm assign the
local security privileges.

Step 3

Granular recovery is automatically provided for a
VMware backup that protects SharePoint Server. You
do not need to enable it in the policy.

See “Add a policy for SharePoint” on page 58.

For backups in non-virtual environments, select
Enable granular recovery in the backup policy.

Step 4

Disk storage units supported with SharePoint Granular Recovery
Technology (GRT)

Granular information is only cataloged for a backup image that is made to a disk
storage unit. A backup that is made directly to tape does not contain granular
information. You can duplicate the image to tape, but you cannot directly back up
to tape. If you configure backups to a disk storage unit, no further configuration is
required. You can only perform restores of individual items using GRT if the backup
resides on a disk storage unit.

More information is available on the disk storage units that are supported with GRT.

See NetBackup Enterprise Server and Server - Hardware and Cloud Storage
Compatibility List.
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Limitations and conditions for restores that use SharePoint Granular
Recovery Technology (GRT)

The following limitations and conditions exist for jobs using Granular Recovery
Technology (GRT):

■ The feature is limited to certain versions of SharePoint Server and Windows
Server. See the Software Compatibility List (CL) and the Application/Database
Agent Compatibility List.

■ This feature only supports full and user-directed backups. NetBackup lets you
create a complete policy for disaster recovery, with all the various types of
schedules. However, you cannot restore individual items from an incremental
backup.

■ NetBackup does not support Granular Recovery Technology (GRT) withMicrosoft
SharePoint Server backups in a multi-tenant SharePoint environment.

■ Backups must be made to a disk storage unit, not to tape, and restores that use
GRT must be made from a disk storage unit. You can manually duplicate the
backup image to disk, but you cannot restore from the tape copy.

■ Backups with GRT do not support any content databases that exist on multiple
servers in a farm.

■ Granular Recovery with Remote BLOB Storage providers is not supported;
however, you can backup and restore the entire farm or databases. Refer to
the following TechNote.
Remote BLOB Storage (RBS) and NetBackup

■ When you perform a granular recovery of documents, pictures, or list items that
are part of a workflow, the state of these items is not preserved.

■ NetBackup does not support backups and restores with GRT if you use a
third-party document management software to manage your SharePoint
documents. For example, NextDocs.

■ (SharePoint 2016 and later) If you edit the title of a list item, SharePoint creates
a new version for those list items. When you select all list item versions for
restore, NetBackup creates a new list item for only those versions whose title
is different than the original list item title. As a workaround, restore the list.

■ (SharePoint 2016 and later) If the list item version you selected for restore has
a different title than the original list item title and the Restore over existing
items option is also enabled, the restore job fails with an error message. As a
workaround, restore the list.

■ (SharePoint 2016 and later) When you use Granular Recovery Technology
(GRT) to restore ghosted or uncustomized aspx pages from any template, the
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restore job is successful, but the restored pages appear with the default content
when it was created. This issue is not seen if the aspx pages are uploaded to
SharePoint. Such pages are treated as customized pages.
To work around this issue, restore the SharePoint web application content
database. See “Redirecting the restore of a SharePoint Server Web application
content database to an alternate SQL Server instance” on page 91.

■ The Restore GRT Basic Meeting Workspace shows errors when you restore
even though the restore completed.

■ The following site templates are not supported with SharePoint restores that
use GRT:

■ Product Catalog

■ Community Site

■ If you perform a restore with Granular Recovery Technology (GRT), any
SharePoint user ratings and tags are synchronized to the current settings of the
user rating and tags in the respective metadata databases.

■ Dependent items of blog posts (including comments and images) are not restored
with restores that use Granular Recovery Technology (GRT).

■ When you restore a list item from a localized subsite, the job is reported as
successful. However the list item fails to appear in the SharePoint user interface.
To work around this issue, restore the item to a file system and upload the item
to SharePoint.

Configuring the logon account for the NetBackup
Client Service for NetBackup for SharePoint
Server

The NetBackup Client Service must log on with an account that has local
administrator and SharePoint farm administrator privileges.

Configure the service for the hosts where the Index Files or Index databases and
where the document libraries reside. For any backups that use Granular Recovery
Technology (GRT), configure this service on all SQL Server back-end servers.

Note: For VMware backups and restores, configure the NetBackup Client Service
on the systems that you use to browse for backups and the systems you use to
perform restores.
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To configure the logon account for the NetBackup Client Service for
NetBackup for SharePoint Server

1 In the Windows Services application, open the NetBackup Client Service
entry.

2 On the Log On tab, provide the following:

■ For the Log on as account, provide the account name that has local
administrator and SharePoint farm administrator privileges.

■ Type the password.

3 Stop and start the NetBackup Client Service.

Configuring the logon account for the NetBackup
Legacy Network Service and the NetBackup
Legacy Client Service

The NetBackup Legacy Network Service must log on with the Local System account.
Optionally, you can also configure the NetBackup Legacy Client Service with the
Local System account.

Configure the service for the hosts where the Index Files or Index databases and
where the document libraries reside. For the backups that use Granular Recovery
Technology (GRT), configure the service on all SQL Server back-end servers.

To configure the logon account for the NetBackup Legacy Network Service
and the NetBackup Legacy Client Service

1 In the Windows Services application, open the NetBackup Legacy Network
Service entry.

2 On the Log On tab, provide the following:

■ For the Log on as account, select Local System account.

■ Type the password.

3 Stop and start the NetBackup Legacy Network Service.

4 (Optional) Follow the same process for the NetBackup Legacy Client Service.

Configuring SharePoint client host properties
In the SharePoint client host properties you configure settings for the SharePoint
clients you selected. Configure the host properties for all servers in the SharePoint
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farm. The options available in this dialog box are based on the version of NetBackup
installed on the client system.

To configure SharePoint client host properties

1 Open the NetBackup web UI.

2 On the left, click Hosts > Host properties.

3 Select the SharePoint client that you want to configure.

If the client does not appear in the list, click Configure hosts > Configure
client.

4 If necessary, click Connect. Then click Edit client.

5 ClickWindows client > SharePoint.

6 Enable the options you want.

See “SharePoint properties” on page 41.

7 Click Save.

SharePoint properties
To access this setting, in the web UI select Hosts > Host properties. Select the
Windows client. If necessary clickConnect, then click Edit client. Click SharePoint.

The SharePoint properties protect SharePoint Server installations and apply to the
currently selected Windows client.

For complete information on these options, see the NetBackup for Microsoft
SharePoint Server Administrator’s Guide.

The SharePoint host properties contain the following settings.

Table 4-4 SharePoint host properties

DescriptionProperty

Specifies the domain and the user name for the account you
want to use to log on to SharePoint (DOMAIN\user name).

See “Reviewing the auto-discovered mappings” on page 46.

See “Configuring the account that logs on to the SharePoint
application server” on page 42.

Domain\Username

Specifies the password for the account.Password
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Table 4-4 SharePoint host properties (continued)

DescriptionProperty

Specifies the consistency checks to perform on the SQL
Server databases before NetBackup begins a backup
operation. These checks are performed for both
server-directed and user-directed backups.

If you choose to perform a consistency check, you can select
Continue with backup if consistency check fails.
NetBackup then continues to perform the backup if the
consistency check fails.

See “Performing consistency checks with NetBackup for
SharePoint Server backups” on page 44.

See “Consistency check options for SharePoint Server”
on page 44.

Consistency check before
backup

For any VMware backups that protect Federated SharePoint
configurations, provide the name of the back-end SQL server.
This server acts as the granular restore proxy host for the
catalog hosts (front-end servers in the farm).

See “Configuring the granular proxy host for Federated
SharePoint configurations with VMware” on page 100.

SharePoint granular restore
proxy host

Configuring the account that logs on to the SharePoint application
server

To perform backups and restores, NetBackup must know the username and
password of the account for the SharePoint administrator. NetBackup also requires
this information so you can browse for SharePoint objects when you create a backup
policy. NetBackup validates the username and password you provide.

This account must meet the following requirements:

■ Have the following rights on the servers where the SharePoint components are
installed: Local administrative privileges and site collection administration rights.

■ SharePoint farm administrator account.

■ The front-end server must have registry access to the back-end database
servers.

■ Have certain local security privileges on the servers which have the content of
the SharePoint farm.
See “Configuring local security privileges for the SharePoint Servers” on page 43.
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■ Internet Information Services (IIS) rights can affect database backups and
restores. Ensure that the logon account that is used for backups and restores
has rights to access the IIS sites. IntegratedWindows Security should be enabled
within the IIS rights.

To specify the logon account for the SharePoint application server

1 Open the NetBackup web UI.

2 On the left, click Hosts > Host properties.

3 Select the Windows client.

4 If necessary, click Connect. Then click Edit client.

5 ClickWindows Client > SharePoint.

6 Specify the user ID and password of the SharePoint Application Server.

7 Click Save.

8 Repeat this configuration for all servers in the SharePoint farm.

9 Configure the local security privileges for the SharePoint Servers.

See “Configuring local security privileges for the SharePoint Servers”
on page 43.

Configuring local security privileges for the SharePoint Servers
On each SharePoint server in the farm you must assign certain local security
privileges. These privileges are necessary since the NetBackup for SharePoint
Server Agent logs on as the SharePoint user when it accesses data.

To configure the local security privileges

1 Open the Local Security Policy.

2 Click Local Policies.

3 In the User Rights Assignment, add the account to the following policies:

■ Allow log on locally

■ Debug programs

■ Log on as a service

■ Replace a process level token

4 Run the group policy update command (group policy update) for this change
to take effect:

gpupdate /Force
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Performing consistency checks with NetBackup for SharePoint Server
backups

You can perform consistency checks of the SQLServer databases before NetBackup
begins a SharePoint backup operation. These checks are performed for both
server-directed and user-directed backups.

To perform consistency checkswith NetBackup for SharePoint Server backups

1 Open the NetBackup web UI.

2 On the left, click Hosts > Host properties.

3 Select the SharePoint client that you want to configure.

If the client does not appear in the list, click Configure hosts > Configure
client.

4 If necessary, click Connect. Then click Edit client.

5 ClickWindows client > SharePoint.

6 From the Consistency check before backup list, choose which check
NetBackup should perform before backups.

See “Consistency check options for SharePoint Server” on page 44.

If you choose to perform a consistency check, you can select Continue with
backup if consistency check fails. NetBackup then continues to perform the
backup if the consistency check fails.

7 Click Save to save your changes.

8 Repeat this configuration for all servers in the SharePoint farm.

Consistency check options for SharePoint Server
The following consistency checks can be performed before a SharePoint Server
backup.

Table 4-5 Consistency check options

DescriptionOption

Do not perform consistency checking.None

Select this option to exclude indexes from the consistency check. If indexes are not
checked, the consistency check runs significantly faster but is not as thorough. Only
the data pages and clustered index pages for each user table are included in the
consistency check. The consistency of the non-clustered index pages is not checked.

Full check, excluding
indexes
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Table 4-5 Consistency check options (continued)

DescriptionOption

Include indexes in the consistency check. Any errors are logged.Full check, including
indexes

See “Performing consistency checks with NetBackup for SharePoint Server backups”
on page 44.

Configuringmappings for restores of a distributed
applications, clusters, or virtual machines

NetBackup catalogs backup images under the SharePoint front-end server name.
To allow NetBackup to restore content to each server in the farm, you must map
the SharePoint Central Administration server with the SQL Server back-end servers.
Configure these mappings in the Distributed Application Restore Mapping host
property on the primary server.

To configure mappings for restores of a distributed application, cluster, or
virtual machine

1 On the left, click Hosts > Host properties.

2 Select the primary server.

3 If necessary, click Connect. Then click Edit primary server.

4 Select Distributed application restore mapping.

5 Click Add.

6 Provide the name of the application host and the name of the component host.

The application host is the SharePoint Central Administration server. The
component host is the SQL Server back-end server that needs access to the
backup image. See Table 4-6.

Example entries for a single front-end SharePoint server
with a clustered SQL Server back-end server
Table 4-6 Example entries for a single front-end SharePoint server with a

clustered SQL Server back-end server

Component hostApplication host

sql-virtualnameSharePoint Central Administration server

sql-node1SharePoint Central Administration server
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Table 4-6 Example entries for a single front-end SharePoint server with a
clustered SQL Server back-end server (continued)

Component hostApplication host

sql-node2SharePoint Central Administration server

Example entries for a single front-end SharePoint server
with a SQL Server availability group back-end server
Table 4-7 Example entries for a single front-end SharePoint server with a

SQL Server availability group back-end server

Component hostApplication host

sql-listenernameSharePoint Central Administration server

sql-node1SharePoint Central Administration server

sql-node2SharePoint Central Administration server

Example entries for SharePoint hosts for a VMware backup
Table 4-8 Example entries for SharePoint hosts for a VMware backup

Component hostsApplication hosts

Physical name of SharePoint central
Administration Server

VM Display name of node

See “Configuring a SharePoint backup that uses Granular Recovery Technology
(GRT)” on page 36.

Reviewing the auto-discovered mappings
In certain scenarios, a NetBackup host shares a particular name with other hosts
or has a name that is associated with a cluster. To successfully perform backups
and restores with NetBackup for SharePoint Server, you must approve each valid
auto-discovered mapping that NetBackup discovers in your environment. Or,
manually add the mappings.

See the section called “Approve the auto-discovered mappings for a cluster”
on page 47.

See the section called “Manually map host names” on page 50.

Examples of the configurations that have multiple host names include:

46Configuring NetBackup for SharePoint Server
Reviewing the auto-discovered mappings



■ A host is associated with its fully qualified domain name (FQDN) and its short
name or its IP address.

■ For SharePoint Server, the nodes in a clustered back-end SQL Server are
associated with the virtual name of the SQL Server.

These mappings are configured in the Security > Host mappings node in the
NetBackup web UI. You can also use the nbhostmgmt command to manage the
mappings. See the NetBackup Security and Encryption Guide and NetBackupWeb
UI Administrator's Guide for more details.

Auto-discovered mappings for a cluster
If you have a clustered back-end SQL Server, you must map the node names to
the virtual name of the cluster if the following apply:

■ If the backup policy includes the cluster name (or virtual name)

■ If the NetBackup client is installed on more than one node in the cluster, the
virtual name must be mapped to each node.
If the NetBackup Client is only installed on one node, then no mapping is
necessary.

Approve the auto-discovered mappings for a cluster
To approve the auto-discovered mappings for a cluster

1 In the NetBackup web UI, expand Security > Host mappings.

2 Click the Mappings to approve tab.

The list displays the hosts in your environment and the mappings or additional
host names that NetBackup discovered for those hosts. A host has one entry
for each mapping or name that is associated with it.

For example, for a cluster with hosts client01.lab04.com and
client02.lab04.com, you may see the following entries:

Auto-discovered mappingHost

client01client01.lab04.com

clusternameclient01.lab04.com

clustername.lab04.comclient01.lab04.com

client02client02.lab04.com

clusternameclient02.lab04.com

clustername.lab04.comclient02.lab04.com
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3 Click the name of the host.

4 Review the mappings for the host and click Approve if you want to use the
discovered mappings.

For example, if the following mappings are valid for client01.lab04.com, then
you approve them.

Valid name forAuto-discovered mapping

The short name of the clientclient01

The virtual name of the clusterclustername

The FQDN of the virtual name of the
cluster

clustername.lab04.com

5 When you finish approving the valid mappings for the hosts, click on theHosts
tab.

For hosts client01.lab04.com and client02.lab04.com, you see entries
for Mapped host or IP address that are similar to the following:

Mapped host names/IP addressesHost

client01.lab04.com, client01, clustername,
clustername.lab04.com

client01.lab04.com

client02.lab04.com, client02, clustername,
clustername.lab04.com

client02.lab04.com

6 If you need to add a mapping that NetBackup did not automatically discover,
you can add it manually.

In Table 4-9 FCI is a SQL Server failover cluster instance.

Table 4-9 Example mapped host names for a single front-end SharePoint
server with a clustered back-end SQL Server

Mapped host namesHostEnvironment

SQL Server cluster virtual
name

Physical name of Node 1FCI (cluster with two nodes)

SQL Server cluster virtual
name

Physical name of Node 2
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Approve the auto-discovered mappings for a SharePoint
SQL Server availability group backup and restore
To approve the auto-discovered mappings for a SharePoint SQL availability
group

1 In the NetBackup web UI, expand Security > Host mappings.

2 Click the Mappings to approve tab.

The list displays the hosts in your environment and the mappings or additional
host names that NetBackup discovered for those hosts. A host has one entry
for each mapping or name that is associated with it.

For example, for a SharePoint SQL Server with hosts client01.lab04.com
and client02.lab04.com, you may see the following entries:

Auto-discovered mappingHost

client01, clustername,
clustername.lab04.com

client01.lab04.com

aglistenernameclient01.lab04.com

aglistenername.lab04.comclient01.lab04.com

client02, clustername,
clustername.lab04.com

client02.lab04.com

aglistenernameclient02.lab04.com

aglistenername.lab04.comclient02.lab04.com

3 Click the name of the host.

4 Review the mappings for the host and click Approve if you want to use the
discovered mappings.

For example, if the following mappings are valid for client01.lab04.com, then
you approve them.

Valid name forAuto-discovered mapping

The short name of the clientclient01

The listener name of the SharePoint SQL
Server availability group

aglistenername

The FQDN of the listener name of the
SharePoint SQL Server availability group.

aglistenername.lab04.com
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5 When you finish approving the valid mappings for the hosts, click on theHosts
tab.

For hosts client01.lab04.com and client02.lab04.com, you see entries
for Mapped host or IP address that are similar to the following:

Mapped host names/IP addressesHost

client01.lab04.com, client01,
aglistenername, aglistenername.lab04.com

client01.lab04.com

client02.lab04.com, client02,
aglistenername, aglistenername.lab04.com

client02.lab04.com

6 If you need to add a mapping that NetBackup did not automatically discover,
you can add it manually.

Manually map host names
If you need to add a mapping that NetBackup did not automatically discover, you
can add it manually.

To manually map host names

1 In the NetBackup web UI, expand Security > Host mappings.

2 Click on the Hosts tab.

3 Click Add shared or cluster mappings.

For example, type the name of the virtual name of the cluster. Then click Add
to choose the hosts to which you want to map that virtual name.

Perform a manual backup
After you configure the servers and assets in your environment, you can test the
configuration settings with a manual backup. Perform amanual backup (or backups)
from a policy with the automatic backup schedules that you created.

To perform a manual backup from a policy

1 On the left, select Protection > Policies.

2 Select the policy you want to test.

3 Select Manual backup.
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4 Select the schedule that you want to use for the manual backup.

5 Select the clients that you want to include for the manual backup.

A parent job contains the whole file list and one or more child jobs. A child job
is automatically launched for each host that contains SharePoint data. For
example, assume that a SharePoint farm consists of four separate hosts. In
this case, one parent job and four child jobs appear in the Activity Monitor. The
front-end web server is listed as the client name for all jobs.
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Configuring NetBackup for
SharePoint Server backup
policies

This chapter includes the following topics:

■ About backup policies for granular backup and recovery of SharePoint Server

■ About backup policies for SharePoint farm backup and recovery

■ About backup policies for disaster recovery of SharePoint Server

■ About VMware backup policies that protect SharePoint Server

■ About configuring a backup policy for SharePoint

About backup policies for granular backup and
recovery of SharePoint Server

A SharePoint granular backup provides you with the ability to restore individual
items from the backup using Granular Recovery Technology (GRT). This type of
backup does not provide protection for the full farm or disaster recovery. GRT only
supports full backups. NetBackup lets you create a complete policy for disaster
recovery, with all the various types of schedules. However, you cannot restore
individual items from an incremental backup.

5Chapter



Note: The Microsoft SharePoint Resources:\AllWebs directive includes the
SharePoint administration sites in a backup. However, granular recovery of the
SharePoint Central Administration website and the Shared Services Administration
website is not supported.

Create an MS-SharePoint policy for each individual web application or create a
policy with the Microsoft SharePoint Resources:\AllWebs directive. Enable the
Enable granular recovery option in the policy. (See Table 5-1, see Policy A or B.)

See “Configuring a SharePoint backup that uses Granular Recovery Technology
(GRT)” on page 36.

Table 5-1 NetBackup for SharePoint Server policy examples for granular
recovery

Other configurationEnable
granular
recovery

Auto
backup
frequency

Backup selectionsPolicy and
policy type

The backup image must reside on a disk
storage unit.

YesWeekly FullMicrosoft SharePoint
Resources:\AllWebs

Policy A

MS-SharePoint

The backup image must reside on a disk
storage unit.

YesWeekly FullMicrosoft SharePoint
Resources:\Web
application name

Policy B

MS-SharePoint

About backup policies for SharePoint farmbackup
and recovery

A farm-level backup provides a complete backup of the SharePoint installation. It
does not, however, provide for disaster recovery, as some components must be
backed up with an MS-Windows policy. Granular recovery is not available from
this type of backup. If you enable granular recovery with this policy, NetBackup
backs up only SQL Server objects in the farm.

SharePoint farm backups
You can back up a SharePoint farm in one of following ways:

■ Create aMS-SharePoint policy to back up the entire farm, but exclude the Index
Files and Search databases from incremental backups. Optionally, you can
create another policy if you want to back up the Index Files and Search
databases more frequently. See Table 5-2.
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■ Create two MS-SharePoint policies. One policy backs up the entire farm and
excludes the Index Files and Search from full and incremental backups. The
other policy backs up the Index Files and Search databases. See Table 5-3.

Table 5-2 NetBackup for SharePoint Server policy example for full farm
backups

Other configurationEnable
granular
recovery

Auto
backup
frequency

Backup selectionsPolicy and
policy type

Exclude the Index Files and Search
databases from the incremental backups.
For the incremental schedule, add the
following directive to the exclude list:

Microsoft SharePoint Resources:\Shared
Services\Shared Services
Applications\Search Service Application
name

NoWeekly Full

Daily
Incremental

Microsoft SharePoint
Resources:\*

Policy A

MS- SharePoint

This policy is optional. If a weekly full backup
does not provide adequate protection, adjust
the schedule accordingly. Ensure that Policy
A and Policy B run at different times, ideally
on different days.

NoMore than
once a week

Microsoft SharePoint
Resources:\Shared
Services\Shared
Services
Applications\Search
Service Application
name

(Optional) Policy
B

MS-SharePoint

Table 5-3 NetBackup for SharePoint Server full farm backup, with separate
policy for Index Files and Search databases

Other configurationEnable
granular
recovery

Auto
backup
frequency

Backup selectionsPolicy and
policy type

Exclude the Index Files and Search
databases from the full and the incremental
backups. Add the following directive to the
exclude list:

Microsoft SharePoint Resources:\Shared
Services\Shared Services
Applications\Search Service Application
name

NoWeekly Full

Daily
Incremental

Microsoft SharePoint
Resources:\*

Policy A

MS-SharePoint
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Table 5-3 NetBackup for SharePoint Server full farm backup, with separate
policy for Index Files and Search databases (continued)

Other configurationEnable
granular
recovery

Auto
backup
frequency

Backup selectionsPolicy and
policy type

If a weekly full backup does not provide
adequate protection, adjust the schedule
accordingly.

NoWeekly FullMicrosoft SharePoint
Resources:\Shared
Services\Shared
Services
Applications\Search
Service Application
name

Policy B

MS-SharePoint

About backup policies for disaster recovery of
SharePoint Server

To provide for full disaster recovery of SharePoint Server, you must create a
farm-level backup and a Windows backup of certain file system components. The
Windows backup should include the file system where SharePoint Web Parts can
be installed and System State directive (Shadow Copy Components). A backup of
the System State protects the IIS metadata.

SharePoint backups for disaster recovery
You can create backup policies for disaster recovery of a SharePoint in one of
following ways:

■ Create a MS-SharePoint policy and an MS-Windows policy. The first policy
backs up the entire farm, but excludes the Index Files and Search databases
from incremental backups. The second policy backs up the components that
reside outside of SharePoint.
See Table 5-4.
Optionally, you can create another policy if you want to back up the Index Files
and Search databases more frequently.

■ Create twoMS-SharePoint policies and anMS-Windows policy. One SharePoint
policy backs up the entire farm and excludes the Index Files and Search from
full and incremental backups. The other SharePoint policy backs up the Index
Files and Search databases. TheMS-Windows policy backs up the components
that reside outside of SharePoint. See Table 5-5.
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Table 5-4 NetBackup for SharePoint Server backup for disaster recovery

Other configurationEnable
granular
recovery

Auto backup
frequency

Backup selectionsPolicy and
policy type

Exclude the Index Files and Search
databases from the incremental backups.
For the incremental schedule, add the
following directive to the exclude list:

Microsoft SharePoint Resources:\Shared
Services\Shared Services
Applications\Search Service Application
name

NoWeekly Full

Daily
Incremental

Microsoft SharePoint
Resources:\*

Policy A

MS- SharePoint

Exclude any databases from this policy.
Add the paths for any databases to the
exclude list.

NoWeekly Full

Daily
Incremental

Shadow Copy
Components:\

ALL_LOCAL_DRIVES

Policy B

MS-Windows

This policy is optional. If a weekly full
backup does not provide adequate
protection, adjust the schedule
accordingly. Ensure that Policy A and
Policy C run at different times. Ideally
these policies should run on different days.

NoMore than once
a week

Microsoft SharePoint
Resources:\Shared
Services\Shared
Services
Applications\Search
Service Application
name

(Optional) Policy
C

MS-SharePoint

Table 5-5 NetBackup for SharePoint Server backup for disaster recovery,
with a separate policy for Index Files and Search databases

Other configurationEnable
granular
recovery

Auto backup
frequency

Backup selectionsPolicy and
policy type

Exclude the Index Files and Search
databases from the full and the
incremental backups. Add the following
directive to the exclude list:

Microsoft SharePoint Resources:\Shared
Services\Shared Services
Applications\Search Service Application
name

NoWeekly Full

Daily
Incremental

Microsoft SharePoint
Resources:\*

Policy A

MS- SharePoint
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Table 5-5 NetBackup for SharePoint Server backup for disaster recovery,
with a separate policy for Index Files and Search databases
(continued)

Other configurationEnable
granular
recovery

Auto backup
frequency

Backup selectionsPolicy and
policy type

If a weekly full backup does not provide
adequate protection, adjust the schedule
accordingly.

NoWeekly FullMicrosoft SharePoint
Resources:\Shared
Services\Shared
Services
Applications\Search
Service Application
name

Policy B

MS-SharePoint

Exclude any databases from this policy.
Add the paths for any databases to the
exclude list.

NoWeekly Full

Daily
Incremental

Shadow Copy
Components:\

ALL_LOCAL_DRIVES

Policy C

MS-Windows

About VMware backup policies that protect
SharePoint Server

VMware backups that protect SharePoint Server provide granular recovery, complete
protection of the farm, and protection of the SharePoint components in theWindows
files system. These system components include SharePoint Web Parts and the
System State directive (Shadow Copy Components). This version of NetBackup
does not support a VMware incremental backup that protects SharePoint Server.

More information is available on how to configure a VMware backup that protects
SharePoint.

See “About protecting an application database with VMware backups” on page 95.

See the NetBackup for VMware Administrator's Guide.

About configuring a backup policy for SharePoint
A backup policy defines the backup criteria for a specific group of one or more
clients.

These criteria include the following:

■ Storage unit and media to use

■ Policy attributes
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■ Backup schedules

■ The clients to back up

■ A backup selections list that defines the objects to back up

See “Add a policy for SharePoint” on page 58.

Add a policy for SharePoint
This topic describes how to create a policy to protect a database.

To add a policy for SharePoint

1 Open the NetBackup web UI.

2 On the left, select Protection > Policies. Then select Add.

3 Type a unique name for the new policy.

4 From the Policy type list, select MS-SharePoint.

5 (Optional) To enable restores of individual items from database backups, click
Enable granular recovery.

See “Configuring a SharePoint backup that uses Granular Recovery Technology
(GRT)” on page 36.

6 Complete the entries on the Attributes tab.

See “About policy attributes” on page 59.

7 Add other policy information as follows:

■ Add schedules.
See “Add schedules to a NetBackup for SharePoint Server policy”
on page 60.

■ Add clients.
See “Add clients to a policy” on page 63.

■ Add database objects to the backup selections list.
See “Creating a backup selections list for a SharePoint Server policy”
on page 64.

8 When you have completed the policy configuration, select Create.

9 For backups that use Granular Recovery Technology (GRT), configure the list
of SharePoint hosts.

See “Configuring mappings for restores of a distributed applications, clusters,
or virtual machines ” on page 45.
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About policy attributes
With a few exceptions, policy attributes for a MS-SharePoint policy are managed
in the same way as for most other policy types. Certain policy attributes vary
according to your specific backup strategy and system configuration.

For more information on policy attributes, see the NetBackup Administrator’s Guide,
Volume I.

Table 5-6 Policy attributes for NetBackup for SharePoint Server policies

DescriptionAttribute

Determines the types of clients that can be backed up with the policy. For SharePoint
databases, select the policy type MS-SharePoint.

Policy type

Limits the number of jobs that NetBackup performs concurrently with this policy. Set this
option to 1 for the policies that are used to back up SharePoint databases.

Limit jobs per policy

Checkpoint restart is not supported with NetBackup for SharePoint Server policies.Take checkpoints
every

Allows the restore of individual items using Granular Recovery Technology (GRT). Documents
external to the document library such as lists, calendars, and discussion boards cannot be
restored individually. Users can only restore individual items from a full backup.

You can restore individual items only if the backup image resides on a disk storage unit. If
you want to retain a granular backup on tape, you must duplicate the image. If you want to
restore from a granular backup that was duplicated to tape, you must import the image to a
disk storage unit.

See “Disk storage units supported with SharePoint Granular Recovery Technology (GRT)”
on page 37.

SharePoint GRT-enabled backups do not support encryption or compression.

Enable granular
recovery

A textual description of a backup. Useful for browsing backups and restores.Keyword phrase
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Table 5-6 Policy attributes for NetBackup for SharePoint Server policies
(continued)

DescriptionAttribute

Select this option to use NetBackup Accelerator to potentially increase the speed of full
VMware backups. By reducing the backup time, it is easier to perform the VMware backup
within the backup window. To use this feature, you must first perform an initial backup with
Use Accelerator enabled. Subsequent backup times can then be significantly reduced.

Accelerator support for SharePoint currently restricts backups to the full schedule type. This
restriction also exists for a VMware backup that protects SharePoint without Accelerator.

To periodically establish a new baseline of change detection on the client, create a separate
policy schedule with the Accelerator forced rescan option enabled.

This feature requires the Data Protection Optimization Option license. For supported storage
types, see NetBackup Enterprise Server and Server - Hardware and Cloud Storage
Compatibility List.

For more details on Accelerator with VMware backups, see the NetBackup for VMware
Administrator's Guide.

Use Accelerator

Add schedules to a NetBackup for SharePoint Server policy
Each policy has its own set of schedules. These schedules control the initiation of
automatic backups and also specify when user operations can be initiated.

To add a schedule to a NetBackup for SharePoint Server policy

1 Open the policy and select the Schedules tab.

2 Select Add.

3 Specify a unique name for the schedule.

4 Select the Type of backup.

See “NetBackup for SharePoint Server backup types” on page 62.

5 Choose a frequency level appropriate for the type of backup.

6 Specify the other properties for the schedule.

See “Schedule properties” on page 60.

7 Select Add.

Schedule properties
This topic describes the schedule properties that have a different meaning for
database backups than for file system backups. Other schedule properties vary
according to your specific backup strategy and system configuration. Additional
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information about other schedule properties is available. See the NetBackup
Administrator’s Guide, Volume I.

Table 5-7 Description of schedule properties

DescriptionProperty

Specifies the type of backup that this schedule can control. The selection list shows only
the backup types that apply to the policy you want to configure.

See “NetBackup for SharePoint Server backup types” on page 62.

Type of backup

You can schedule an automatic backup in one of the following ways:

■ Calendar
TheCalendar option lets you schedule the backup operations that are based on specific
dates, recurring week days, or recurring days of the month.

■ Frequency
The Frequency specifies the period of time that can elapse until the next backup operation
begins on this schedule. For example, assume that the frequency is 7 days and a
successful backup occurs on Wednesday. The next full backup does not occur until the
following Wednesday.
Typically, incremental backups have a shorter frequency than full backups.

Schedule type

Specifies a retention period to keep backup copies of files before they are deleted. The
retention level also denotes a schedule priority within the policy. A higher level has a higher
priority. Set the time period to retain at least two full backups of your database. In this way,
if one full backup is lost, you have another full backup to restore. For example, if your
database is backed up once every Sunday morning, you should select a retention period
of at least 2 weeks.

Retention

The type of schedule you select affects the retention period as follows:

■ Frequency-based scheduling
Set a retention period that is longer than the frequency setting for the schedule. For
example, if the frequency setting is set to one week, set the retention period to be more
than one week. The NetBackup scheduler compares the latest record of the automatic
backup schedule to the frequency of that automatic backup schedule. This comparison
is done to determine whether a backup is due. So if you set the retention period to expire
the record too early, the scheduled backup frequency is unpredictable. However, if you
set the retention period to be longer than necessary, the NetBackup catalog accumulates
unnecessary records.

■ Calendar-based scheduling
The retention period setting is not significant for calendar-based scheduling.

Effect of type of
schedule on retention
period
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NetBackup for SharePoint Server backup types
Table 5-8 describes the type of backups that are available with the SharePoint
Agent.

Table 5-8 Description of types of backups

DescriptionType of Backup

Select this back up type to back up the entire SharePoint component
database(s). Granular-level backups must be backed up with a full
backup.

A list is available for the objects that support full backups.

See Table 5-9.

Full Backup

A user backup is not automatically scheduled and is initiated from
the front-end web server. This schedule allows for granular recovery.

You may want a separate policy for User Backup schedule types.
With a separate policy, you can easily separate user-directed and
scheduled backups when you restore files. If you create a separate
policy for User Backup schedule types, the considerations are
similar to those for automatic backups. A backup selections list is
not needed because users select the files before the backup begins.

User Backup

This type of backup is not supported for SharePoint Server.Cumulative
Incremental backup

Select this backup type to only back up the changes that are made
to the database since the last full backup or previous incremental
backup. You cannot restore individual items from an incremental
restore.

A list is available for the objects that support incremental backups.

See Table 5-9.

Note: The SharePoint Index Files only support full backups. To
minimize storage unit space consumption, it is recommended that
you back up the Index Files and their corresponding Search
databases with a different policy.

Note: Incremental backups are not supported for granular-level
backups.

Differential
Incremental backup

Table 5-9 describes the schedule types that are supported for SharePoint Server
and SharePoint Foundation objects.
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Table 5-9 Schedule types supported for SharePoint Server and SharePoint
Foundation objects

Schedule typeSharePoint/SharePoint Foundation
objects

Full backup, Differential Incremental backupConfiguration DB

Full backup, Differential Incremental backupGlobal Settings

Full backup, Differential Incremental backupSingle Sign-On

Full backupWeb Application/Content DB/ (including
individual document restores)

Full backup, Differential Incremental backupShared Services/Services DB

Full backupShared Services/Shared Search Index/Index
Files

Full backupShared Services/Shared Search Index/
Search DB

Full backup, Differential Incremental backupShared Services/Web App/Content DB

Add clients to a policy
The clients list contains a list of the clients that are backed up during an automatic
backup. A NetBackup client must be in at least one policy but can be in more than
one.

The NetBackup client software must be installed on each of the following: the
front-end web server, the SQL Server database host, and the Index Files or the
Index database host. The client software does not need to be installed on the Search
or the Job servers. If the SQL Server is clustered,

To add clients to a policy

1 Open the policy and select the Clients tab.

2 Select Add.
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3 Add the client that is the front-end web server and that runs the Central
Administration Service to the client list.

Note: You must perform additional configuration if the SQL Server back-end
servers are clustered and you installed NetBackup on more than one node in
the cluster.

See “Reviewing the auto-discovered mappings” on page 46.

See “Configuring mappings for restores of a distributed applications, clusters,
or virtual machines ” on page 45.

4 Select Detect client operating system to automatically detect the client
computer's operating system and hardware.

5 Select Add.

Creating a backup selections list for a SharePoint Server policy
The backup selections list defines the SharePoint objects to be backed up and the
grouping of SharePoint objects for multiple data streams. You can specify the entire
farm or back up individual SharePoint components, such as a Single Sign-on,
Configuration, or Content database. You can also use wildcards to specify a group
of objects.

Cohesity recommends that you create backup selections with the browse feature.
Because SharePoint objects have long names, it is easy to mistype the object name
when you create backup selections by adding and editing directives. One exception
is the Microsoft SharePoint Resources:\AllWebs directive. Use this directive
to back up all Web applications. You do not need to add a separate backup selection
for each Web application.

To browse for the SharePoint objects, you must provide the credentials for the
account that logs on to the SharePoint Server.

See “Configuring the account that logs on to the SharePoint application server”
on page 42.

To perform backups with multiple data streams, you must enable this feature on
theAttributes tab for the policy and define the backup streams with the NEW STREAM

directive.
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Creating a backup selections list to back up SharePoint
Server objects
To create a backup selections list to back up SharePoint Server objects

1 Open the NetBackup web UI.

2 Open the policy that you want to edit.

3 Click the Backup selections tab.

4 Click Add.

5 Click the Browse option to browse for a SharePoint object.

6 In the left pane, expand the client and select the object you want to back up.

If you selected Enable granular recovery on the Attributes tab, the display
is limited to Web applications.

7 Click Add.

8 Repeat step 4 through step 7 for each object you want to add.

Creating a backup selections item for all Web applications
To create a backup selections item for all Web applications

1 Open the NetBackup web UI.

2 Open the policy that you want to edit.

3 Click the Backup selections tab.

4 Click Add.

5 From the Pathname of directive drop-down list, selectMicrosoft SharePoint
Resources:\AllWebs.

This directive works for both Web applications.

6 Click Add.

PerformingSharePoint backupswithmultiple data streams
NetBackup lets you divide a backup so that each job backs up only a part of the
backup selections list. To divide the backup into multiple jobs, insert the NEW_STREAM
directive at a certain point or points in the backup selections list to define where
each stream begins.

Backup jobs are divided as follows:

■ When you specify NEW_STREAM directives in your policy, NetBackup creates a
new job for each NEW_STREAM directive in the policy.
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■ If you use wildcard characters to define SharePoint objects in the backup
selections list, those objects are backed up in the same stream.

■ When you back upmultiple SharePoint databases, NetBackup groups the backup
jobs by the selected server.

For more information on the multiple data streams feature, see the NetBackup
Administrator's Guide, Volume I.

Using wildcards in a SharePoint backup selections list
Wildcard characters can be used to define groups of databases. This way multiple
objects can be backed up without having to specify the objects individually in the
backup selections list. For example, you may have a farm with a large number of
Web applications or have Web applications with many content databases. You can
use wildcard characters to indicate groups of Web applications and use the
NEW_STREAM directive to divide the backup into multiple jobs, as follows:

See “Performing SharePoint backups with multiple data streams” on page 65.

Table 5-10 Supported wildcard characters

ActionWildcard character

Use as a substitute for zero or more characters. Specify
the asterisk as the last character in the string.

Example: To specify all objects that start with an a use
a*.

Asterisk (*)

Use as a substitute for one or more characters in a name.

Example 1: The string s?z processes all objects that
have s for a first character, any character for a second
character, and z for a third character.

Example 2: The string Data??se processes all objects
that have Data as the first four characters, any
characters for the fifth and sixth characters, and se as
the seventh and eighth characters.

Question mark (?)
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Table 5-10 Supported wildcard characters (continued)

ActionWildcard character

Use to match any one character that is enclosed in
square brackets. A hyphen (-) can be used to indicate
a range of consecutive characters; for example, [0-9] is
equivalent to [0123456789].

Note: The hyphen (-) loses this special meaning if it
occurs last in the string.

Note: The right square bracket (]) does not terminate
such a string when it is the first character within it. For
example, [] a-f]matches either a right square bracket
(]) or one of the ASCII letters a through f inclusive.
Asterisk (*) and question mark (?) stand for themselves
within such a string of characters.

Left & right brackets ([ ... ])

The following rules apply when wildcard characters are used in the backup selections
list:

■ Only one wildcard pattern per backup selections list entry is allowed.

■ If a wildcard pattern is not honored it is treated literally.

■ Wildcard patterns are honored only in the final segment of the path name.
Correct
Microsoft SharePoint Resources:\WebApp*

Microsoft SharePoint Resources:\WebApp[A-D]

Microsoft SharePoint Resources:\WebAppDept?

Incorrect
Microsoft SharePoint Resources:\Shared Services\*\Content DB

Configuring exclude lists for SharePoint clients
If you need to exclude certain SharePoint objects, you can create an exclude list.
WhenNetBackup runs a NetBackup for SharePoint Server backup policy, NetBackup
ignores the items that appear in the exclude list.

For more information on how to create an exclude list, see the NetBackup Web UI
Administrator's Guide. NetBackup excludes certain files and directories by default.
These default exclusions always appear in the exclude list.

You can exclude any SharePoint object from a backup. You can specify the exclude
list for all policies or for a specific policy or schedule.
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SharePoint object names can be lengthy. You can type an object name in the
exclude list manually. Or it may be easier to locate the object through a remote
browse (from backup selections in the NetBackup policy). Then copy the object
name from there to the exclude list.

Note: For SQL Servers in a cluster, you must select each node and perform the
configuration procedure on each node. You must configure the same settings on
each node. If you change the attributes for the virtual name of the client, NetBackup
updates only the active node or current node.

To configure a SharePoint client exclude list

1 Open the NetBackup web UI.

2 On the left, click Hosts > Host properties.

3 Select the SharePoint client that you want to configure.

If the client does not appear in the list, click Configure hosts > Configure
client.

4 If necessary, click Connect. Then click Edit client.

5 ExpandWindows client > Exclude lists.

6 Click Add.

7 Specify objects to exclude in one of the following ways:

■ In the Policy field, select All policies or type the name of a specific policy.

■ In the Schedules field, select All schedules or type the name of a specific
schedule.

■ In the Name or path field, type the name of a SharePoint object in the
following format:
For Web applications:
Microsoft SharePoint Resources:\Windows SharePoint Foundation

Web Application\app name

■ To exclude a specific database, type the name of a specific database
after the Web application name.

■ To exclude Index Files and their Search databases, use one of the
following directives.
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Microsoft SharePoint Resources:\Shared Services\Shared Service
Applications\Search Service Application name

8 (Conditional) Repeat step 3 through step 7 for the other nodes in the
environment.

Perform this step if the NetBackup environment is clustered or replicated.

If you specify the name of the virtual client, only the active node or current node
is updated. For the changes to be effective throughout the cluster, repeat the
configuration steps on each node.
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Performing backups and
restores of SharePoint
Server and SharePoint
Foundation

This chapter includes the following topics:

■ About user-directed backups of SharePoint Server and SharePoint Foundation

■ About restores of SharePoint Server and SharePoint Foundation

About user-directed backups of SharePoint Server
and SharePoint Foundation

User-directed backups of SharePoint Server must be performed from the front-end
Web server. Back up the Content, Services, and User profile databases together.

If the policy that has a user backup schedule enables consistency checks, these
checks are also performed before user-directed backups.

Note: If you open multiple backup windows (in the NetBackup client) to browse
SharePoint resources, the windows may unexpectedly terminate. Instead, use a
single backup window to browse SharePoint resources for backup.

6Chapter



Specifying the server and client for a SharePoint Server backup
operation

When you perform user backups of a SharePoint Server, you can specify the server
that you want to perform the backups.

To specify the server and client for a backup operation

1 Log onto the server as Administrator.

2 Open the Backup, Archive, and Restore interface.

3 Select File > Specify NetBackup Machines and Policy Type.

4 In the Specify NetBackup Machines and Policy Type dialog box, provide
the following information:

Select the server you want to perform the backup.Server to use for backups
and restores

Not applicable for SharePoint backups.Source client for restores
(or virtual client for
backups)

5 Click OK.

About backup options for NetBackup for SharePoint Server
Table 6-1 lists the options that are available when you perform backups of a
SharePoint Server.

Table 6-1 Backup options

DescriptionOption

Identify the NetBackup server that you want to perform the
backup.

Backup to NetBackup
server

Contains a list of objects to be backed up.Items marked to be
backed up

Specify a keyword phrase, up to 128 characters in length, that
NetBackup can associate with the image created by this backup
operation. You then can restore the image by specifying the
keyword phrase in the Search Backups dialog box.

All printable characters are permitted including space (" ") and
period ("."). The default keyword phrase is the null (empty) string.

Keyword phrase to
associate with the
backup or archive
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See “Performing a user-directed backup of SharePoint Server and SharePoint
Foundation” on page 72.

See “Restoring individual SharePoint items from full database backups” on page 82.

Performing a user-directed backup of SharePoint Server and
SharePoint Foundation

This topic describes how to perform a user-directed backup of SharePoint Server
and SharePoint Foundation.

To back up SharePoint resources

1 Log onto the server as Administrator.

2 Open the Backup, Archive, and Restore interface.

3 Choose File > Select Files and Folders to Back Up.

4 In the All Folders pane, expand Microsoft SharePoint Resources.

5 Select the objects to back up.

6 Choose Actions > Backup. Then click Start Backup.

See “About backup options for NetBackup for SharePoint Server” on page 71.

If you want to view the progress of the backup, click Yes. If you do not want
to view the progress of the backup, click No.
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About restores of SharePoint Server and
SharePoint Foundation

Note the following when you perform restores:

■ The NetBackup for SharePoint Server Agent supports a restore to the same
Microsoft service pack (SP) or cumulative update (CU) on which the backup
was originally created. Microsoft sometimes introduces database schema
changes in SPs or CUs. If you restore to a different SP or CU level, the database
server may not operate correctly.

■ Administer restores from the NetBackup primary server or the SharePoint
front-end server.

■ When you select an item for restore, do not select (or mark) items in the All
Folders pane. In the All Folders pane, click on, but do not select the check
box for the parent folder. Then, in the Contents of pane, select the specific
object you want to restore.

■ The Configuration database contains all of the configuration information for the
entire SharePoint server farm. Use caution when you restore this database;
upon restore, any changes are lost that you made to the farm topology after the
backup was performed.

■ When you select for restore some but not all Content databases for a Web
application, theWeb application is not provisioned. After you restore the selected
Content databases, those databases are re-attached.

■ Even if SharePoint components exist on multiple computers, all the backups
are cataloged under the same SharePoint server name. Once you select that
server name, all available backup images for your SharePoint environment are
displayed.

■ When you redirect a restore to a file system, any list items you selected are not
restored and appear as 0-KB files.

■ Restores that use GRT must be made from a disk storage unit. You cannot
restore from the tape copy.

■ When you restore a site collection, any non-default theme you applied is not
restored with the site collection. You must reapply the theme manually after the
restore. This limitation does not affect restores of sub sites.

See “Limitations and conditions for restores that use SharePoint Granular Recovery
Technology (GRT)” on page 38.
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Specifying the server, client, and the policy type for a SharePoint
Server restore operation

When you perform restores, you select the following information:

■ The primary server that performed the backup

■ The SharePoint front-end client that was backed up

■ The SharePoint policy type

To specify the server, client, and policy type for a SharePoint Server restore
operation

1 Log onto the server as Administrator.

2 Open the Backup, Archive, and Restore interface.

3 Click File > Specify NetBackup Machines and Policy Type.

4 In the Specify NetBackup Machines and Policy Type dialog box, from the
Server to use for backups and restores list, select the NetBackup server
that performed the restore.

5 From the Source client for restores list, select the client.

The source client is the SharePoint Server front-end client whose backup
images you want to browse.

6 From the Policy type for restores list, choose MS-SharePoint.

7 Click OK.

Restore options for SharePoint Server on the Microsoft SharePoint
tab

On this tab you can choose to bring databases online after a restore job. You can
also specify a different location to which to redirect a web application. The farm and
the web application to which you want to redirect the restore must already exist.

Table 6-2 Microsoft SharePoint tab

DescriptionOption

Select this option to bring the databases online after a restore job. This option also
re-establishes the link between the restored databases and their corresponding web
applications.

Bring restored
databases online and
reconnect previous
database links
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Table 6-2 Microsoft SharePoint tab (continued)

DescriptionOption

If the website and the application pool for the SharePoint web application that you restore
already exists in IIS, this option preserves them during restore. If you do not check this option,
the website and the application pool are deleted from IIS during the restore. After they are
deleted, they are recreated in the default location that SharePoint specifies.

Preserve existing
Internet Information
Services (IIS) Web
site and application
pool

If versioning is enabled on the destination to which you want to restore an individual item or
document, select one of the following options:

■ Add as a new version
NetBackup restores the existing item or document as a new version, which makes it the
most recent version of the existing item. For example, assume that you have five versions
of testfile.doc and choose to restore version 2.0 of the file. When the file is restored,
it is added as testfile.doc 6.0 and is the most recent version.

■ Skip if the item exists
NetBackup does not restore the item if an identical item or document exists in the restore
destination. NetBackup notes that the file was skipped in the job log.

■ Restore over existing items
NetBackup restores the existing item as a new version and deletes the existing version.
For example, assume that the version history is as follows:

testfile.doc version 3.0
testfile.doc version 2.0
testfile.doc version 1.0

testfile.doc version 3 is the most recent version. If you choose to restore
testfile.doc version 2.0, the restore adds testfile.doc version 4.0 and deletes
testfile.doc version 2.0. So the version history appears as follows:

testfile.doc version 4.0
testfile.doc version 3.0
testfile.doc version 1.0

testfile.doc version 2.0 is now version 4.0 of the file.

Note: The version of the restored file depends on the Versioning Settings selected for
that library or list in SharePoint.

If versioning is
enabled on the
restore destination
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Table 6-2 Microsoft SharePoint tab (continued)

DescriptionOption

If versioning is not enabled on the destination to which you want to restore an individual item,
select one of the following options:

■ Skip if the item exists
NetBackup does not restore the item if an identical item exists in the restore destination.
NetBackup indicates that the file was skipped in the log.

■ Restore over existing items
NetBackup replaces the existing item with the restored item.

If versioning is not
enabled on the
restore destination

Check this option to only restore the most recent version of an item. Note that NetBackup
restores the most recent version of the versions you selected for restore. If a more recent
version exists, but you did not select it for restore that version is not restored.

Restore only themost
recent version of an
item

Check this option to restore any applicable security information with the item. Note that
security information is restored only if you select a parent folder and not when you select
individual items. For example, security information is restored when you select Shared
Documents, but not if you select an individual document. However, an individual object can
have user permissions that are defined with a level of “limited access.” In this case,
permissions for those users are not restored with that object.

You can restore different levels of security based on the SharePoint item you restore:

■ Sites
User and SharePoint Group information and security ACL are restored for top-level sites.

■ Subsites
Security ACL is restored.

■ Lists
Security ACL and other security-related information are restored.

Include security
information

Check this option to redirect a Web application. Then select one of the following:

■ Web application
■ Alternate SQL instance

Redirect SharePoint
Resources

Select this option to redirect a Web application to another Web application.

■ In the URL box, specify the URL of the destination site. For example:
http://URL to Web application

■ In the Front end web server name box, indicate the host name of the web server to
which you want to redirect. The web server must already exist on the destination location.

See “Redirecting a restore of a SharePoint web application within a farm” on page 87.

See “Redirecting a restore of a SharePoint Web application to another farm” on page 89.

Web application
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Table 6-2 Microsoft SharePoint tab (continued)

DescriptionOption

Note: Select only one database to redirect. If you select multiple databases, all databases
are written to the target database.

Select this option to redirect a web application to an alternate SQL instance.

In the SQL Server\Instance box, indicate the name of the target SQL Server and the target
instance name.

In the Target Database box, indicate the name of the target database.

See “Redirecting the restore of a SharePoint Server Web application content database to an
alternate SQL Server instance” on page 91.

Alternate SQL
instance

How the NetBackup Recovery Assistant restores SharePoint Server
and SharePoint Foundation

The NetBackup Recovery Assistant launches a restore job for each database in a
Web application. Databases are restored in the proper order to ensure that a working
Web application exists when the restore is complete. After all the databases are
restored any items you selected are restored in a single job.

The Recovery Assistant restores objects in the following order:

■ Configuration databases (only if assistant is run in disaster recovery mode)

■ Content databases

■ Services databases

■ Index Files

■ Document sets, documents, lists, etc.

Objects are skipped if they are not found in the database configuration. Each restore
may only restore a portion of the components depending on what objects you select
and the backup image you select. When you restore an item, it does not restore an
entire Content database or Document library.

Restoring SharePoint Server and SharePoint Foundation
Multiple SharePoint Server resources can be restored together. The NetBackup
Recovery Assistant determines the order in which the resources must be restored.
You can restore any of the SharePoint resources in separate restore operations.
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Note: NetBackup does not prevent you from restoring placeholders. NetBackup
also lets you restore any object that can hold a document, even if it does not contain
a document.

Restoring SharePoint Server

1 Enable the front-end Web server to redirect restores to the SQL Server hosts
in the farm.

A redirected restore is performed since backups are cataloged under the
front-end client name for the Federated SharePoint farm.

See “Configuring mappings for restores of a distributed applications, clusters,
or virtual machines ” on page 45.

2 Log on as Administrator.

3 Open the Backup, Archive, and Restore interface.

4 Choose File > Select Files and Folders to Restore > from Normal Backup.

5 Select the MS-SharePoint policy type.

See “Specifying the server, client, and the policy type for a SharePoint Server
restore operation” on page 74.

6 Click OK.

NetBackup browses for SharePoint Server backup images.

7 From theNetBackup History pane, select the image(s) that contain the objects
you want to restore:

■ The last full backup, or

■ The last full backup and all subsequent differential backups

8 In the All Folders pane, expand Microsoft SharePoint Resources.

Note:When you select items to restore, do not check the checkbox for an item
in the All folders pane. Only check the checkbox for an item in the Contents
of pane.

9 In the Contents of pane, check the checkbox for the SharePoint resources to
restore.

To select a database, click on (but do not check the checkbox for) the parent
folder in the All Folders pane. Then check the checkbox for the database in
the Contents of pane.

78Performing backups and restores of SharePoint Server and SharePoint Foundation
About restores of SharePoint Server and SharePoint Foundation



If you want to restore a subsite, expand the site collection in the All Folders
pane. Then check the checkbox for the subsite in Contents of pane.

Note: For a successful restore, you must select the Index Files folder(s) exactly
as described here.

If you want to restore the SharePoint Index Files, do the following:

■ In the All Folders pane, click on the folder for the Shared Services
Application but do not select the checkbox for it.

■ In the Contents of pane, select each Index Files folder.

10 Choose Actions > Restore.
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11 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.

See “Restore options for SharePoint Server on the Microsoft SharePoint tab”
on page 74.

12 Click Start Restore.

Restoring the SharePoint Search Service Application
The following instructions describe how to restore the Shared Services Application.
Select all of the components of the Search Service application for recovery. The
SharePoint Agent un-provisions the Search service application, restores the
components, and recovers the Search service application.

To restore the SharePoint Search Service Application

1 Open the NetBackup Backup, Archive, and Restore interface.

2 Open a Restore window.

3 Select the full backup that contains the shared services.

4 In the All Folders pane, expandMicrosoft SharePoint Resources > Shared
Services > Shared Services Applications.

5 Select each Index Files folder for restore as follows:

Note: For a successful restore, you must select the Index Files folders exactly
as described here.

■ In the All Folders pane, click on the folder for the Shared Services
Application but do not select the checkbox for it.

■ In the Contents of pane, select each Index Files folder.
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6 Select each Shared Services database for restore as follows:

Note: For a successful restore, you must select the databases exactly as
described here.

■ In theAll Folders pane, click on the folder for the Shared Services database
but do not select the checkbox for it.

■ In the Contents of pane, select the Shared Services database.
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7 Choose Actions > Restore.

8 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.

9 UncheckBring restored databases online and reconnect previous database
links.

10 Click Start Restore.

11 Restore any incremental backups. Do not select Bring restored databases
online and reconnect previous database links except for the last incremental
backup.

About requirements for restores of individual SharePoint items using
Granular Recovery Technology (GRT)

The following requirements must bemet to restore individual items from full database
backups Granular Recovery Technology (GRT):

■ The administrator has configured NetBackup to allow for restores of individual
items (Enable granular recovery). This option is on the Attributes tab for the
backup policy.
See “About policy attributes” on page 59.

■ The user must restore from a full backup image.

■ You can only restore an individual item when the backup image resides on a
disk storage unit.
See “Disk storage units supported with SharePoint Granular Recovery
Technology (GRT)” on page 37.

Restoring individual SharePoint items from full database backups
You can restore individual sites, subsites, documents, images, and list items from
the full SharePoint database backup jobs that use Granular Recovery Technology
(GRT).

Note:Granular recovery of the SharePoint Central Administration web site and the
Shared Services Administration web site is not supported.
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Note:When you restore an item, it is safe to ignore certain bprd errors in the Activity
Monitor similar to the following:

7/12/2021 11:01:39 AM - Error bpdm (pid=2928) did not receive EXIT

STATUS from bprd, all blocks may not have been restored

Instead, rely on the final status that is reported in the Activity Monitor to determine
the true success or failure of the restore operation.

To restore individual SharePoint items from full database backups

1 Enable the SharePoint front-endWeb server to restore to the SQL Server hosts
in the farm.

See “Configuring mappings for restores of a distributed applications, clusters,
or virtual machines ” on page 45.

2 Log on as Administrator.

3 Open the Backup, Archive, and Restore interface.

4 Choose File > Select Files and Folders to Restore > from Normal Backup.

5 Select the MS-SharePoint policy type.

See “Specifying the server, client, and the policy type for a SharePoint Server
restore operation” on page 74.

6 Click OK.

NetBackup browses for SharePoint Server backup images.

7 From the NetBackup History pane, select the full backup image that contains
the items you want to restore.

8 In the All Folders pane, expand Microsoft SharePoint Resources.

Note:When you select items to restore, do not check the checkbox for an item
in the All folders pane. Only check the checkbox for an item in the Contents
of pane.

9 In the Contents of pane, select the items to restore.

Note that security information is restored only if you select a parent folder and
not when you select individual items. For example, security information is
restored when you select Shared Documents, but not if you select an individual
document. However, an individual object can have the user permissions that
are defined with a level of “limited access.” In this case, permissions for those
users are not restored with that object.
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10 Choose Actions > Restore.

11 Click the Microsoft SharePoint tab.

12 Choose your restore options, as follows:

Select one of the following options:

■ Add as a new version
NetBackup restores the existing item as a new version, making it the most recent
version of the existing item.

■ Skip if the item exists
NetBackup does not restore the item if an identical item exists in the restore
destination. NetBackup notes that the file was skipped in the job log.

■ Restore over existing items
NetBackup restores the existing item as a new version and deletes the existing
version.

If versioning is enabled on the
restore destination

Select one of the following options:

■ Skip if the item exists
NetBackup does not restore the item if an identical item exists in the restore
destination. NetBackup notes that the file was skipped in the job log.

■ Restore over existing items
NetBackup replaces the existing item with the restored item.

If versioning is not enabled on
the restore destination

Check this option if you only want to restore the most recent versions of any individual
items you have selected for restore.

Restore only the most recent
version of an item

Check this option if you want to restore the SharePoint security information that is
attached to the items you restore.

Include security information
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13 Select the other restore options you want.

See “Restore options for SharePoint Server on the Microsoft SharePoint tab”
on page 74.

14 Click Start Restore.

Recovering a SharePoint Web application in a farm with multiple
front-end servers

To restore a deleted web application in a Network Load Balanced (NLB) farm, you
may need to perform amanual operation using the SharePoint Central Administration
interface. After the restore operation is successful, if the Web application on the
NLB farm is offline, perform the following steps.

Note: After you complete the following steps, a change is reflected in the IIS
attributes for the primary configured balanced node. The new balanced load server
contains two sites: the original site and the name of the latest site that you create
in step 13. However, both sites link to the original site and there is no effect on the
environment.

To recover a SharePoint Web application in a farm with multiple front-end
servers

1 Log on as Administrator.

2 Open the Backup, Archive, and Restore interface.

3 Choose File > Select Files and Folders to Restore > from Normal Backup.

4 Select the MS-SharePoint policy type.

See “Specifying the server, client, and the policy type for a SharePoint Server
restore operation” on page 74.

5 Click OK.

NetBackup browses for SharePoint Server backup images.

6 From the NetBackup History pane, select the images that contain the objects
you want to restore:

■ The last full backup, or

■ The last full backup and all subsequent differential backups
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7 In the All Folders pane, expand Microsoft SharePoint Resources and the
Web application.

Note:When you select items to restore, do not check the checkbox for an item
in the All folders pane. Only check the checkbox for an item in the Contents
of pane.

8 In the Contents of pane, select the Content database.

9 Restore the database to the primary front end.

Note that you only need to perform this action once.

10 Open the SharePoint Central Administration interface.

11 Under Central Administration, click Application Management.

12 Under SharePoint Web Application Management, click Create or extend
Web application.

13 Select Extend an existing Web application.

14 Do the following to extend the Web application:

■ Click on the link for the Web application and select Change Web
Application. Fill in the values to extend the restored Web application.

■ Select Create a new IIS web site and fill in the information to match the
original Web application. However, you cannot use the same port number.

■ In the Load Balanced URL section, provide the node name of the load
balanced server. (For example, http://VMSP-3:new port.)

15 After you complete step 14, all other configured front-endsmay be automatically
updated with IIS entries. If so, no further action is required.

If other front-ends require load balancing, then repeat step 12 through step 14.

Restoring a deleted SharePoint list
To restore a list that you deleted, you need to restore the list and default.aspx in
separate restore jobs.

To restore a deleted list

1 Log on as Administrator.

2 Open the Backup, Archive, and Restore interface.

3 Choose File > Select Files and Folders to Restore > from Normal Backup.
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4 Select the MS-SharePoint policy type.

See “Specifying the server, client, and the policy type for a SharePoint Server
restore operation” on page 74.

5 Click OK.

NetBackup browses for SharePoint Server backup images.

6 From the NetBackup History pane, select the images that contain the objects
you want to restore:

■ The last full backup, or

■ The last full backup and all subsequent differential backups

7 In the All Folders pane, expand Microsoft SharePoint Resources.

Note:When you select items to restore, do not check the checkbox for an item
in the All folders pane. Only check the checkbox for an item in the Contents
of pane.

8 From the Contents of pane, select the list item you deleted or the library
container for the list.

9 Click Start Restore.

When the restore completes, continue with the next step.

10 In the All Folders pane, expand Microsoft SharePoint Resources.

11 From the Contents of pane, in the subsite or the site collection, select
default.aspx.

12 Click Start Restore.

Redirecting a restore of a SharePoint web application within a farm
A web application restore can be redirected within the same farm or to a different
farm. For instructions on how to redirect to a different farm, see the following topic:

See “Redirecting a restore of a SharePoint Web application to another farm”
on page 89.

Note the following when you redirect a web application within a farm:

■ The source web application cannot be a live web application.

■ The web application target to which you want to redirect the restore must already
exist on the specified web server.

■ The target must have the same database structure as the source web application.
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■ You can only redirect a web application from a full backup. Redirection is not
supported from differential backups.

■ You can restore configuration databases and single sign-on databases back to
the original location only. Document sets and individual SharePoint items must
be restored to their original site.

■ You can redirect a restore of a web application within the same farm. The SQL
Server database host and the SharePoint host must be the same. A redirected
restore is not supported if the SQL Server databases exist across multiple SQL
hosts.

■ You must restore all SQL Server databases in one operation at the same time.

To redirect a restore of a SharePoint web application within a farm

1 Log on as Administrator.

2 Create the target web application on the target web server. The target site
must have the same database structure as the source site.

3 Remove the source web application.

If you attempt the redirected restore without removing the source, the restore
completes successfully, but the databases are not properly connected to the
virtual server.

4 Open the Backup, Archive, and Restore interface.

5 Click File > Select Files and Folders to Restore > from Normal Backup.

6 Select the MS-SharePoint policy type.

See “Specifying the server, client, and the policy type for a SharePoint Server
restore operation” on page 74.

7 From the NetBackup History pane, select the full backup image that contains
the objects you want to restore.

8 In the All Folders pane, expand Microsoft SharePoint Resources.

Note:When you select items to restore, do not check the check box for an
item in the All folders pane. Only check the check box for an item in the
Contents of pane.

9 In the Contents of pane, select the web application to redirect.

10 Click Actions > Restore.

11 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.

12 Check Redirect SharePoint Resources.
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13 ClickWeb application.

14 In the URL box, type the URL of the destination site:

http://webapp

15 In the Front end web server name box, indicate the host name of the web
server.

16 For information on other restore options in this dialog box, see the following
topic:

See “Restore options for SharePoint Server on the Microsoft SharePoint tab”
on page 74.

17 Click Start Restore.

Redirecting a restore of a SharePoint Web application to another
farm

A Web application restore can be redirected within the same farm or to a different
farm. For instructions on how to redirect within a farm, see the following topic:

See “Redirecting a restore of a SharePoint web application within a farm”
on page 87.

Note the following when you redirect a Web application to another farm:

■ TheWeb application target to which you want to redirect the restore must already
exist on the specifiedWeb server. It also must have the same number of content
databases as the source Web application.

■ The target Web application and SQL Server database name must have new
names (different from original names).

■ The SharePoint version from the source farmmust match the SharePoint version
of the destination farm.

■ You can only redirect a Web application from a full backup. Redirection is not
supported from differential backups.

■ The Web applications must be restored at the database level.

■ The destination SharePoint farm nodes must be in the NetBackup domain.

■ In the host properties for the primary server, configure the Distributed
Application Restore Mapping settings.
These settings must contain the mapping for the destination farm. A distributed
application must have all the farm nodes of the destination SharePoint farm
mapped as components of the source SharePoint front end.
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■ The Windows Client Properties for the destination farm nodes must be set for
SharePoint for all nodes in the farm.

■ A NetBackup client must be installed on all nodes of the destination farm.

■ You cannot complete a redirected restore if the SQL Server databases exist
across multiple SQL hosts.

■ You must restore all redirected Web application SQL Server databases in one
operation at the same time.

■ You cannot redirect a Web application to the same farm more than once. This
restriction ensures SQL Server database ID uniqueness.

■ The SharePoint version of the source and destination must be the same.

■ The SQL version of the source and destination must be the same.

■ You must manually restore from the MS-Windows backup image any custom
Web parts that were created on the file system. These components are not
backed up with the MS-SharePoint policy. (For example, you must manually
restore C:\inetpub\wwwroot\wss\VirtualDirectories\port number.)

To redirect a restore of a SharePoint Web application to another farm

1 Log on as Administrator.

2 Create the target Web application on the target Web server.

3 Open the Backup, Archive, and Restore interface.

4 Click File > Select Files and Folders to Restore > from Normal Backup.

5 Select the MS-SharePoint policy type.

See “Specifying the server, client, and the policy type for a SharePoint Server
restore operation” on page 74.

6 From the NetBackup History pane, select the full backup image that contains
the objects you want to restore.

7 In the All Folders pane, expand Microsoft SharePoint Resources.

Note:When you select items to restore, do not check the checkbox for an item
in the All folders pane. Only check the checkbox for an item in the Contents
of pane.

8 In the Contents of pane, select the Web application to redirect.

9 Click Actions > Restore.

10 In the Restore Marked Files dialog box, click the Microsoft SharePoint tab.
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11 Check Redirect SharePoint Resources.

12 ClickWeb application.

13 In the URL box, type the URL of the destination site:

http://webapp:port

Use the URL that appears in SharePoint Central Administration.

14 In the Front end web server name box, indicate the host name of the target
Web server.

See “Restore options for SharePoint Server on the Microsoft SharePoint tab”
on page 74.

15 Click Start Restore.

Redirecting the restore of a SharePoint Server Web application
content database to an alternate SQL Server instance

You can redirect a SharePoint Web application content database to an alternate
SQL Server instance to take advantage of SharePoint data recovery from an
unattached content database. The target database must be a new database.

To redirect the restore of a SharePoint Server database to an alternate SQL
Server instance

1 Open the Backup, Archive, and Restore interface.

2 Click File > Select Files and Folders to Restore > from Normal Backup.

3 Select the MS-SharePoint policy type.

See “Specifying the server, client, and the policy type for a SharePoint Server
restore operation” on page 74.

4 From the NetBackup History pane, select the full backup image that contains
the objects you want to restore.
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5 In the All Folders pane, expand Microsoft SharePoint Resources.

Note:When you select items to restore, do not check the checkbox for an item
in the All folders pane. Only check the checkbox for an item in the Contents
of pane.

6 In the Contents of pane, select the Web application content database to
redirect.

7 Click Actions > Restore.

8 Click the Microsoft SharePoint tab.

See “Restore options for SharePoint Server on the Microsoft SharePoint tab”
on page 74.

9 Click Redirect SharePoint Resources.

10 Select Alternate SQL Instance.

11 In the SQL Server\Instance box, type the name of the SQL Server and the
instance name to which you want to redirect the Web application content
database.

12 In the Target Database box, indicate the name of the target database.

13 Click Start Restore.
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Performing recovery using
NetBackup Web UI

This chapter includes the following topics:

■ Prerequisites

■ Backup recovery using NetBackup Web UI

Prerequisites
Ensure that the following prerequisites are completed before initiating the recovery
process using NetBackup Web UI.

■ User: Verify a valid user with appropriate credentials defined in RBAC.
For more information, see Managing role-based access control section in
NetBackup Web UI Administrator's Guide.

■ Backups: Ensure that you have backed up the required items of MS-Exchange
before starting the process. Define a policy with appropriate specifications and
verify the job is successful. NetBackup recommends selecting Enable granular
recovery option when defining a policy.
For more information, see Managing policies section of the NetBackup Web UI
Administrator's Guide.

Backup recovery using NetBackup Web UI
Recovery using NetBackup Web UI

1 Log into NetBackup Web UI.

2 On the left, click Recovery.
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3 In the Regular recovery pane, click Start recovery.

4 Select MS-SharePoint from the Policy type drop down.

Note:NetBackup currently supports onlyNormal backups asRestore types.

5 Click Select client, the original machine where the data was backed up, as
the Source client.

6 Destination client is auto displayed.

7 Click Next.

8 In theRecovery details tab, NetBackup supports granular recovery where the
users can restore individual items. These backup items are displayed in tree
structure. You can filter the selection based on Date range, File or directory
name, and most recent or all backups.

Click Refresh if the backup items to recover are not displayed or contact
Cohesity customer support.

Select the appropriate recovery backup items and then click Next.

9 In the Recovery options tab, select the required options from the following:

See “Restore options for SharePoint Server on the Microsoft SharePoint tab”
on page 74.

■ Restore options

■ Versioning enabled on the restore destination

■ Versioning is NOT enabled on the restore destination

■ Restore only the most recent version of the item

■ Include security information

■ SharePoint redirection

■ Job priority: By default, the preset priority for restore jobs is 90000, which
is the highest preset job priority of any other NetBackup job. The available
range is 0 to 99999. The higher the number, the greater the job priority.

10 Click Next.

11 Review the recovery specifications in the Review tab and then click Start
recovery.

12 A new job is initiated in the Activity monitor.
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Protecting SharePoint
Server data with VMware
backups

This chapter includes the following topics:

■ About protecting an application database with VMware backups

■ About configuring a VMware backup that protects SharePoint Server

■ Restoring SharePoint data from a VMware backup

About protecting an application database with
VMware backups

With a VMware backup policy and the Veritas VSS Provider, NetBackup can create
consistent, full backups of an application database that resides on a virtual machine.

VMware application backups let you:

■ Use the existing database restore process to restore and recover data from
VMware backups.

■ From one VMware backup, choose from these restore options: Disk-level restore,
file-level recovery, database restore, or granular-level restore (GRT).

■ Restore and recover databases from VMware backups to alternate clients. The
target destination client can be a physical computer or a virtual machine.

Supported environments and configuration
See the following information on virtual systems compatibility:
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Veritas VSS Provider
See “Installing the Veritas VSS provider for vSphere” on page 97.

Using NetBackup Accelerator to increase the speed of full
VMware backups
Select theUse Accelerator policy option to use NetBackup Accelerator to potentially
increase the speed of full VMware backups. (This option is not available in the
settings for a protection plan.) By reducing the backup time, it is easier to perform
the VMware backup within the backup window. To use this feature, you must first
perform an initial backup withUse Accelerator enabled. Subsequent backup times
can then be significantly reduced. Accelerator support for database agents currently
restricts backups to the full schedule type.

To periodically establish a new baseline of change detection on the client, create
a separate policy schedule with the Accelerator forced rescan option enabled.

For more details on Accelerator with VMware backups, see the NetBackup for
VMware Administrator's Guide.

Limitations of VMware application backups
Databases are cataloged and protected only for the configurations that are supported
for VMware backups. Make sure to store databases on supported storage.

VMware application backups do not support the following policy options and
configurations:

■ Incremental backups. Instead, you can create a policy for SharePoint Server
incremental backups.

■ Consistency checks of the SharePoint Server.

■ SQL Server clusters or SQL Server availability groups.

■ Any SQL Server back-end servers that service multiple SQL Server instances
for multiple SharePoint farms.

■ SharePoint Server databases are not cataloged and backed up if they exist on
the following:

■ Any virtual machines that use raw device mapping (RDM).

■ Virtual Machine Disk (vmdk) volumes that are marked as independent.

■ Mount point volumes.

■ Virtual hard disks (VHDs).
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■ RAID volumes.

■ ReFS file systems.

■ An excluded Windows boot disk.

■ Any components that reside on a physical computer are not backed up with the
VMware backup.

Limitations for restores from VMware appplication backups
The following limitations exist when you perform restores from VMware application
backups.

■ NetBackup does not support redirection of content databases or web applications
from VMware application backups.

■ NetBackup only supports full VMware backups that protect SharePoint. In a
VMware environment, you cannot restore NetBackup for SharePoint
(MS-SharePoint) differential restores.

Installing the Veritas VSS provider for vSphere
To use the Veritas VSS provider you must install it manually following installation
of the NetBackup for Windows client. If the VMware VSS provider is installed, the
installation program removes it and may require a restart of the computer.

To install the Veritas VSS provider

1 Browse to the following location:

install_path\NetBackup\bin\goodies\

2 Double-click on the Veritas VSS provider for vSphere shortcut.

3 Follow the prompts.

4 When the utility has completed, restart the computer if prompted.

5 Following the restart, the utility resumes. Follow the prompts to complete the
installation.

To uninstall the Veritas VSS provider

1 Open Add or Remove Programs.

2 Double-click on Veritas VSS provider.

The uninstall program does not automatically reinstall the VMware VSS provider.
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About configuring a VMware backup that protects
SharePoint Server

To successfully perform VMware backups and restores of SharePoint Server,
complete the following steps.

Table 8-1 Configuring a VMware backup that protects SharePoint Server

DescriptionActionStep

See the NetBackup for VMware Administrator's
Guide.

Install the NetBackup client software on the
virtual machines that are part of a SharePoint
farm.

Configure your VMware environment and
NetBackup.

Step 1

See “Installing the Veritas VSS provider for
vSphere” on page 97.

Install the Cohesity VSS provider.Step 2

See “Configuring the logon account for the
NetBackup Client Service for NetBackup for
SharePoint Server ” on page 39.

Configure the NetBackup Client Service.Step 3

See “Configuring the logon account for the
NetBackup Legacy Network Service and the
NetBackup Legacy Client Service” on page 40.

Configure the NetBackup Legacy Network
Service and optionally the NetBackup Legacy
Client Service.

Step 4

See “Configuring local security privileges for the
SharePoint Servers” on page 43.

Configure the local security privileges.Step 5

Map the application hosts and component hosts
in your environment.

See “Configuring mappings for restores of a
distributed applications, clusters, or virtual
machines ” on page 45.

On the NetBackup server, configure the
mappings for distributed application restores.

Step 6

In certain scenarios, a NetBackup host has
additional host names or shares a particular
name with other hosts. Approve each valid
auto-discovered mapping that NetBackup
discovers in your environment.

See “Reviewing the auto-discovered mappings”
on page 46.

On the NetBackup server, review the
auto-discovered mappings for the hosts in your
environment.

Step 7
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Table 8-1 Configuring a VMware backup that protects SharePoint Server
(continued)

DescriptionActionStep

See “Requirements for SharePoint Granular
Recovery” on page 20.

See “Configuring a SharePoint backup that uses
Granular Recovery Technology (GRT)”
on page 36.

Review the requirements granular restores.Step 8

See “Configuring the granular proxy host for
Federated SharePoint configurations with
VMware” on page 100.

For Federated SharePoint configurations,
configure the granular proxy on the primary
server.

Step 9

See “Configuring SharePoint client host
properties” on page 40.

Configure the host properties for each
SharePoint client.

Step 10

See “Configuring a VMware backup policy to
protect SharePoint Server” on page 99.

Create a VMware backup policy.Step 11

See “Perform a manual backup” on page 50.Test your configuration settings.Step 12

Configuring a VMware backup policy to protect SharePoint Server
Through a VMware backup policy, NetBackup can create full application-consistent
backups of a SharePoint Server that resides on a virtual machine. Optionally, you
can use NetBackup Accelerator. VMware policies let you exclude certain virtual
disks from the VMware backup. If you want to exclude specific SharePoint
components, use a MS-SharePoint policy.

More information on Accelerator is available:

See “About policy attributes” on page 59.

See the NetBackup Administrator's Guide, Volume I.

To configure a VMware backup policy to protect SharePoint Server

1 On the left, select Protection > Policies.

2 Add a new policy or open the policy that you want to edit.

3 Select the Attributes tab.

■ From the Policy type list, select VMware.

■ In the Policy storage list, select a disk storage unit.
If you want to use NetBackup Accelerator, select a supported storage unit
type. The NetBackup device mapping files list all supported storage types.
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■ If you want to use NetBackup Accelerator, select Use Accelerator.
Accelerator uses the initial full backup to establish a baseline. Any
subsequent backups that are performedwith Accelerator can run significantly
faster. You may want to create an additional policy schedule that enables
the Accelerator forced rescan option. This option establishes a new
baseline for the next Accelerator backup.
Perform block-level incremental backups is automatically selected and
grayed out. On the VMware tab, the Enable block-level incremental
backup option is also selected and grayed out.

4 On the Clients tab, do the following:

■ Select Select automatically through VMware intelligent policy query.

■ From the NetBackup host to perform automatic virtual machine
selection list, select the host you want to use.

■ Use the Query builder to create the rules that select the virtual machines
you want to back up.

5 On the VMware tab:

■ Select the Primary VM identifier to use to catalog the backups.

■ Select Enable file recovery from VM backup.

■ Locate Application protection and selectMicrosoft SharePoint Server.
This option allows recovery of the databases from the virtual machine
backups. If this option is disabled, you can recover the entire virtual machine
from the backup, but you cannot recover the databases individually.
Alternatively, you can select Microsoft SQL Server. Do not select both
recovery options.

6 If you want to exclude certain disks from the VMware backup, select the
Exclude disks tab.

NetBackup excludes those disks from the VMware backup that protects
SharePoint Server. Be sure that any disks that you exclude do not contain
database data.

7 Select Save to save the policy.

Configuring the granular proxy host for Federated SharePoint
configurations with VMware

For a VMware backup that protects Federated SharePoint configurations, you need
to configure the back-end SQL Server as the granular restore proxy host for the
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catalog hosts (front-end servers in the farm). You can perform this configuration on
the primary server or from the command line.

To specify the SharePoint granular restore proxy host

1 On the primary server, open the NetBackup web UI.

2 Expand Hosts > Host properties.

3 Select the SharePoint client that you want to configure.

4 If necessary, click Connect. Then click Edit client.

5 ClickWindows client > SharePoint.

6 In the SharePoint granular restore proxy host box, type the name of the
SQL Server back-end host.

7 Click Save to save your changes.

8 Repeat this configuration for all servers in the SharePoint farm.

Restoring SharePoint data from a VMware backup
SharePoint data is restored from a VMware backup in the same manner that it is
restored from a backup that is performed with the SharePoint Agent. Though you
use a VMware policy type to back up the data, you still use the MS-SharePoint
policy type for the restore. NetBackup displays the SharePoint data in the VMware
backup image that is available for restore.

When you perform a granular restore of SharePoint from multiple VMware
application-aware backup images, browse and restore from one image at a time.

To restore SharePoint data from a VMware backup

1 Log on to the server as Administrator.

2 Open the Backup, Archive, and Restore interface.

3 Click File > Specify NetBackup Machines and Policy Type.

4 From the Server to use for backups and restores list, select the NetBackup
server that performed the restore.

5 From the Source client for restores list, select the name of the SharePoint
front-end server.

Select the server that is listed first alphabetically in the list of front-end servers.

Even if SharePoint components exist on multiple computers, all the backups
are cataloged under the same SharePoint server name. Once you select that
server name, all available backup images for your SharePoint environment are
displayed.
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6 For the Policy type for restores, select MS-SharePoint.

7 Follow the instructions for a SharePoint restore from a non-VMware
environment.

See “About restores of SharePoint Server and SharePoint Foundation”
on page 73.
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Disaster recovery
This chapter includes the following topics:

■ About disaster recovery of a SharePoint Server

■ Requirements for disaster recovery of a SharePoint Server

■ Recovering a SharePoint server (without BMR)

About disaster recovery of a SharePoint Server
Disaster recovery of a SharePoint server cannot be separated from the disaster
recovery of windows because SharePoint server uses the Windows security for
authentication. You must recover the Windows server before you recover the
SharePoint Server.

If you purchased the NetBackup Bare Metal Restore option. Refer to NetBackup
Bare Metal Restore Administrator's Guide for more information. If you do not have
BMR, see the “Disaster Recovery” chapter in the NetBackup Troubleshooting Guide.

Requirements for disaster recovery of a
SharePoint Server

The following requirements exist for disaster recovery of a SharePoint Server:

■ A copy of NetBackup for Windows

■ The primary server has a license for NetBackup for SharePoint Server

■ The latest backup of the SharePoint Server you want to recover

■ The SharePoint Server CD

■ Any service packs that have been applied to the original installation
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See “About disaster recovery of a SharePoint Server” on page 103.

See “Recovering a SharePoint server (without BMR)” on page 104.

Recovering a SharePoint server (without BMR)
This topic describes how to recover a SharePoint server installation without Bare
Metal Restore (BMR).

Be sure to restore the components of the SharePoint Server as described in the
following procedure, in this order:

■ Web applications, one at a time

■ Services (State Service database, metadata, and State Service Proxy)

■ Shared Services databases (service applications and metadata), one at a time

■ SharePoint Foundation Help Search (WSS_Search)

■ InfoPath Forms Services (Metadata)

■ Index files

Note: Do not restore Shared Services Proxies. (When NetBackup restores the
service application it generates new URIs and proxies for the service application.)

To recover a SharePoint server (without BMR)

1 Prepare the SharePoint host for restore. Configure it the same as the original
host.

This configuration may involve new hardware and reinstalling the OS,Windows
services packs, and the software that is needed to restore SharePoint from
backup.

2 Install any prerequisite software and SharePoint.

This installation includes running the SharePoint Products ConfigurationWizard.

3 Create a new farm configuration database using the SharePoint Products
Configuration Wizard.

4 In a web browser, verify that you can access the SharePoint Central
Administration pages and that the configuration includes the original farm
members.

Run the Farm Configuration Wizard, if applicable.

5 Configure the NetBackup primary server and the SharePoint client hosts so
you can restore SharePoint from the backup.
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6 From the front-end server open the NetBackup Backup, Archive, and Restore
interface.

7 Verify that the Microsoft SharePoint Resources:\ are visible.

8 Restore the web applications, one at a time.

For example:

[Microsoft SharePoint Foundation Web Application]

[SharePoint - 80]

9 Restore the services (State Service database, metadata, and State Service
Proxy).

For example:

[Service]

[Microsoft SharePoint Foundation Diagnostics Service\Metadata]

[SPUserCodeV4\Metadata]

[State Service]

[State Service\Proxy]

[Workflow Service Application Proxy\Proxy]

10 Restore the Shared Services databases (service application and metadata),
one at a time.

For example:

[Shared Services]

[Shared Services Applications]

[App Management Service]

[Business Data Connectivity Service]

[Machine Translation Service]

[Managed Metadata Service]

[PowerPoint Conversion Service Application\Metadata]

[Project Server Service Application\Metadata]

[Search Service Application]

[Secure Store Service]

[Security Token Service Application\Metadata]

[User Profile Service Application]

[Word Automation Services]
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11 Restore the SharePoint Foundation Help Search (WSS_Search).

For example:

[WSS_Administration]

[WebApplication]

12 Restore the InfoPath Forms Services (metadata).

For example:

[InfoPath Forms Services]

[Data Connections\Metadata]

[Exempt User Agents\Metadata]

[Form Templates\Metadata]

[Settings\Metadata]

13 Restore the Index Files.

For example:

[Shared Services]

[Shared Services Applications]

[Search Service Application]

14 Restore the configuration database.

For example:

[Configuration V5/V6-DB]

15 Restore the Global Settings.

16 Ensure that all the SharePoint and the SQL services are restarted on the
SharePoint and the SQL Server, including the IIS service.

17 Use the SharePoint Central Administration, IIS, or the NetBackup Backup,
Archive, and Restore interface to browse the web application sites. Verify that
the web application sites that you restored are accessible and were restored
properly.
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Troubleshooting
This chapter includes the following topics:

■ About NetBackup for SharePoint Server debug logging

■ View the progress report of a NetBackup for SharePoint Server operation

■ Restores to different SharePoint service pack or different cumulative update
levels

■ Modified system files or ghost files are not cataloged or restored during a site
collection restore

■ Troubleshooting SharePoint jobs that use Granular Recovery Technology (GRT)

■ About troubleshooting SharePoint restore operations

■ About NetBackup for SharePoint Server and client-side deduplication

■ Troubleshooting VMware backups

About NetBackup for SharePoint Server debug
logging

The NetBackup primary server and client software offers a comprehensive set of
debug logs for troubleshooting problems that can occur during NetBackup
operations. Debug logging is also available for SharePoint Server backup and
restore operations.

See the following topics for information on how to create the logs and how to control
the amount of information written to the logs.

See “Enable the debug logs automatically (SharePoint client)” on page 108.
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See “Enabling the debug logging for NetBackup for SharePoint Server manually”
on page 108.

See “Setting the debug level on a NetBackup for SharePoint Server Windows client”
on page 110.

After you determine the cause of the problem, disable debug logging by removing
the previously created debug logging directories. For details see the NetBackup
Logging Reference Guide.

Additional information about NetBackup client logs and NetBackup primary server
logs is available. See the help for the Backup, Archive, and Restore interface and
the NetBackup Web UI Administrator’s Guide.

Note:When debug logging is enabled, the files can become large. The same files
are used by normal file backups.

Enable the debug logs automatically (SharePoint client)
You can enable debug logging by running a batch file that creates each log directory.
To create all log file directories automatically, run the following:

install_path\NetBackup\logs\mklogdir.bat

Enabling the debug logging for NetBackup for SharePoint Server
manually

To turn on debug logging, create the log directories in the following location:

install_path\NetBackup\logs

Create the following log directories on the SQL Server, the front-end web server,
the media server, and the primary server.

After you create these directories and perform a backup or restore, debug logging
information is placed in a subdirectory that has the name of the process directory.
For legacy logging, the file is named mmddyy.log. For unified logging, the log file
is in a format that is standardized across Cohesity products. To view the logs that
use unified logging, use lv.exe or vxlogview.

For more information about unified logging, see the NetBackup Administrator’s
Guide, Volume I. For information on how to use the log commands, see the
NetBackup Troubleshooting Guide.
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Primary server

All restoresbprd

Media server

All backups & restoresbpbrm

SharePoint GRT backups & restoresnbfsd

Front-end web server

SharePoint managed code on the SharePoint front-end serverbeds

All backupsbpbkar

Snapshot backups, VMware backupsbpfis

SharePoint Granular Recovery Technology (GRT) backups and restoresbpresolver

SharePoint live browse if the image type is VMwarencflbc

VMware Application State Capture (ASC) jobsncfnbcs

Recovery Assistant unified log. This log does not have its own directory.
NetBackup creates this log file in the NetBackup\logs folder with the
following format: 51216-254-*.log.

SPSV2Recovery
Asst

Recovery Assistant legacy logspsv2ra

Non-GRT restorestar

SQL Server

All backupsbpbkar

Snapshot backups, VMware backupsbpfis

SharePoint GRT backups and restoresnbfsd

SharePoint GRT restores.

Increase the ncfrai logging level to add detail.

ncfgre

VMware ASC jobsncfnbcs

Non-GRT restorestar
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See “Troubleshooting SharePoint jobs that use Granular Recovery Technology
(GRT)” on page 113.

See “About troubleshooting SharePoint restore operations” on page 114.

See “About NetBackup for SharePoint Server and client-side deduplication”
on page 115.

Setting the debug level on a NetBackup for SharePoint Server
Windows client

To control the amount of information that is written to the debug logs, change the
General, Verbose, and Database debug levels on the client(s). Typically, the default
value of 0 is sufficient. However, technical support may ask you to set the value
higher to analyze a problem.

The debug logs are located in install_path\NetBackup\logs.

To set the debug level for the legacy process on a NetBackup for SharePoint
Server client

1 Open the Backup, Archive, and Restore program

2 Select File > NetBackup Client Properties.

3 Click the Troubleshooting tab.

4 Set the General debug level.

Set this level as high as 2.

5 Set the Verbose debug level.

Set this level as high as 5.

6 Click OK to save your changes.
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To set the debug level for the processes that use unified logging on a
NetBackup for SharePoint Server client

1 Newer NetBackup processes such as ncfgre use Veritas Unified Logging
(VxUL). To increase VxUL logging level, run the following:

install dir\NetBackup\bin\vxlogcfg -a -p 51216 -o OID -s

DebugLevel=6 -s DiagnosticLevel=6

Replace the OID as follows:

ncfrai = 158

ncflbc = 351

ncfgre = 352

ncfnbcs = 366

SPSV2RecoveryAsst = 254

spsdkservice = 479

For a list of all OID values, see the NetBackup Logging Reference Guide.

2 To reset the VxUL logging level default value, run the following command:

install dir\NetBackup\bin\vxlogcfg -a -p 51216 -o OID -s

DebugLevel=1 -s DiagnosticLevel=1

Veritas VSS provider logs
The Veritas VSS provider records its activities in Windows Event Logs. Debug logs
are also available at the following location:

install_path\Veritas VSS provider\logs

Enabling Veritas VSS provider logging in the registry
Enable the Veritas VSS provider logging on the NetBackup computer where
SharePoint is installed.

To enable Veritas VSS provider logging in the registry

1 Log on as administrator on the computer where NetBackup is installed.

2 Open Regedit.

3 Open the following key:

HKEY_LOCAL_MACHINE\SOFTWARE\Veritas\NetBackup\CurrentVersion\Config

4 Create a new DWORD value named CreateDebugLog.
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5 Right-click on the new value and click Modify.

6 In the Value data box, enter 1.

7 Click OK.

Increasing the Veritas VSS provider log debug level
To increase the log debug level modify both the pre-freeze-script.bat and
post-thaw-script.bat files in the C:\Windows folder. Add the -log parameter to the
script, at the line where BeVssRequestor.exe is called. VMware determines which
script is invoked.

To increase the Veritas VSS provider log debug level

1 Change the following line in the pre-freeze-script.bat:

BeVssRequestor.exe -pre2 -logscreen !SkipExReplica! !SkipSQL!

!VMBackupType! !ExcludeList!

to:

BeVssRequestor.exe -pre2 -logscreen !SkipExReplica! !SkipSQL!

!VMBackupType! !ExcludeList! -log

2 Also change the following line in the post-thaw-script.bat:

BeVssRequestor.exe -post2 -logscreen !SkipExReplica! !SkipSQL!

!VMBackupType! !ExcludeList!

to:

BeVssRequestor.exe -post2 -logscreen !SkipExReplica! !SkipSQL!

!VMBackupType! !ExcludeList! -log

View the progress report of a NetBackup for
SharePoint Server operation

This topic describes how to view the progress report of a NetBackup for SharePoint
Server backup or restore operation.

To view the progress report of a NetBackup for SharePoint Server operation

1 Open the Backup, Archive, and Restore interface.

2 Choose File > View Status.

112Troubleshooting
View the progress report of a NetBackup for SharePoint Server operation



3 Click the task for which you want to check the progress.

4 Click Refresh.

More information is available on progress reports and the meaning of the
messages.

See the NetBackup Backup, Archive, and Restore Getting Started Guide.

Restores to different SharePoint service pack or
different cumulative update levels

The NetBackup for SharePoint Server Agent supports a restore to the same
Microsoft service pack (SP) or cumulative update (CU) on which the backup was
originally created. Microsoft sometimes introduces database schema changes in
SPs or CUs. If you restore to a different SP or CU level, the database server may
not operate correctly.

Modified system files or ghost files are not
cataloged or restored during a site collection
restore

Modified system files or modified ghosted files are neither cataloged nor restored
during a site collection restore. This issue is observed in SharePoint 2016.

To work around this issue, restore the SharePoint web application content database.

Troubleshooting SharePoint jobs that use
Granular Recovery Technology (GRT)

Note the following when you use NetBackup to perform backup or restore operations
using Granular Recovery Technology:

■ Disable or uninstall QLogic SANSurfer software. It may conflict with the
portmapper for Client for NFS.

■ Before you install NFS on the media server or client(s), look for the ONC/RPC
Portmapper service. If it exists, stop it and disable it. Otherwise, the installation
of NFS Services for Windows fails.

■ SharePoint GRT operations can fail for the VM backup images that use display
names that contain parenthesis. For example, a GRT live browse restore from
the Backup, Archive, and Restore (BAR) interface fails with the following error:
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database system error

■ In the Local Security Settings, the Users group must have User Rights
Assignment “Allow log on locally”. By default, the Users group is included. If the
Users group does not have this right, the following error occurs:
1385 -- Logon failure: the user has not been granted the requested logon
type at this computer.

■ Backups of the SharePoint web applications that use Granular Recovery
Technology (GRT) and that contain a larger number of content databases (100+)
may timeout. In this situation, increase the default “Client read timeout” setting
to 900 seconds.

■ NetBackup supports GRT restores of large documents for SharePoint with SQL
Server using SQL Server Native Client 10.0 or later.

■ Technical Support may want nbfsd logs from the media server. Use the Verbose
setting carefully as the nbfsd log can grow very large.

About troubleshooting SharePoint restore
operations

Note the following when you perform restores:

■ NetBackup does not prevent you from restoring placeholders.

■ NetBackup lets you restore any object that can hold a document, even it does
not contain a document.

The following issues also exist for SharePoint:

■ For a SharePoint survey list, after a restore the “Time Created” value reflects
the value at the time of the granular restore. This behavior is by design.

■ If you restore a deleted report, the report ID is incremented upon restore. If you
want to maintain the original report ID value, restore the entire report container.
In SharePoint 2016 and later, if you select the entire report container for restore,
the report IDs post restore are not from the original set and new IDs are created.

■ NetBackup Web UI does not start a GRT restore job from a UNIX NetBackup
primary server. Initiate the restore job from the SharePoint client under which
the backup is cataloged.

■ If you use a SQL Server local RBS provider and want to take a SharePoint data
backup, then you must create a file system policy for file-level backups of
SharePoint databases on the SQL Server.
You can use this backup for database level restores (full and differential)
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■ When you restore a web application a new application pool is created for each
restore. The original application also remains and can be deleted.
See Figure 10-1.

Figure 10-1 New application pool after a web application restore

About NetBackup for SharePoint Server and
client-side deduplication

When you use the NetBackup for SharePoint Server with client-side deduplication,
the job details only show that deduplication occurs on the front-end Web server.
The job is reported this way even if client-side deduplication is enabled for the SQL
client and the other SharePoint farm hosts. Deduplication is performed if you choose
Prefer to use client-side deduplication orAlways use client-side deduplication.

The bpbrm logs contain information on the deduplication process (shown as “Client
Direct”). For example, the log for a SQL Server back-end server is as follows:

15:49:13.947 [4892.8600] <2> bpbrm main: bpbrm.c.2767: Client Direct is using

alternate client: FABLE

15:49:13.947 [4892.8600] <2> initiate_proxy_server: Calling bpcr_start_proxy

with hostname:FABLE

Troubleshooting VMware backups
Note the following when you perform a VMware backup that protects an application:

115Troubleshooting
About NetBackup for SharePoint Server and client-side deduplication



■ The Application State Capture (ASC) job contacts the NetBackup client on the
guest virtual machine and catalogs the application data for recovery.

■ One ASC job is created per VM, regardless of which applications are selected
in the policy.

■ ASC messages are filtered based on the ASC job details in the Activity monitor.

■ The ASC job can result in status 1 (partially success). For example, if SharePoint
was protected, but it was the SQL Server that failed to be protected.

■ Failure results in the discovery job or parent job exiting with Status 1.

■ If you enable recovery for a particular application but that application does not
exist on the VM, the ASC job returns Status 0.

■ bpfis is run and simulates a VSS snapshot backup. This simulation is required
to gain logical information of the application.

Table 10-1 Issues with using a VMware policy to protect databases

ExplanationIssue

Databases are cataloged and protected only if the configuration is supported for VMware
backups.

See “Limitations of VMware application backups” on page 96.

A database backup fails.

NetBackup is installed on an excluded Windows boot disk. The ASC job detects this
type of disk and treats it like an independent disk. Do not select the Exclude boot disk
option if NetBackup is installed on the boot drive (typically C:).

You selected databases for backup that exist on both supported and on unsupported
disks. See “A database backup fails” for unsupported disk information.

ASC job produces a status 1
(partially successful).

116Troubleshooting
Troubleshooting VMware backups



Table 10-1 Issues with using a VMware policy to protect databases
(continued)

ExplanationIssue

When the ASC job fails, the VMware snapshot or backup continues. Application-specific
data cannot be restored.

The Application State Capture
(ASC) job fails and the
databases are not protected.

You disabled the Enable virtual Machine quiesce option.

Database objects are on a VHD disk. No objects in the backup are not cataloged,
including those that do not exist on the VHD.

You excluded any data disks from the VMware policy, on the Exclude disks tab. Be
sure that any disks that you exclude do not contain database data.

The VMware disk layout has changed since the last discovery. In this situation, you
must force NetBackup to rediscover virtual machines by lowering the value of the
Reuse VM selection query results for option. See the NetBackup for VMware
Administrator's Guide.

You cannot use a VMware incremental policy to protect SharePoint Server. However,
the VMware backup job is successful.

There is a Content database with no site collections present. To avoid this issue, remove
the empty Content database or create a site collection in the Content database.

The policy included SQL Servers that host multiple SharePoint farms.

You did not select the Application protection option SharePoint Server on the
VMware tab in the policy, which allows recovery of the databases from the virtual
machine backups.

You can recover the entire
virtual machine from the
backup, but you cannot
recover the databases
individually.

No media server was added in the Additional Servers list.VMware job fails with error
2804.

The Primary VM identifier is not a NetBIOS name (for example, display name or
UUID). For example, a client name like client SP2016 becomes client%20SP2016.
The live browse fails with a database system error because the client name is not
recognized as a valid client name.

Add an entry to the Distributed application restore mapping settings. The Primary
VM identifier is the name of the application host. The front-end client name is the
name of the component host. Alternatively for UNIX primary servers, add the
SPS_REDIRECT_ALLOWED entry to the bp.conf file. Or for Windows primary
servers, add a SPS_REDIRECT_ALLOWED registry entry.

GRT live browse error for a
VMware image that supports
the restore of application
data.
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Table 10-1 Issues with using a VMware policy to protect databases
(continued)

ExplanationIssue

In the VMware policy, you select both Enable SharePoint Recovery and Enable SQL
Recovery. Only select one of these recovery options.

The SQL snapshot
preparation fails.
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